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Operating Conditions

All Delta Tau Data Systems, Inc. motion controller products, accessories, and amplifiers contain static
sensitive components that can be damaged by incorrect handling. When installing or handling Delta Tau
Data Systems, Inc. products, avoid contact with highly insulated materials. Only qualified personnel
should be allowed to handle this equipment.

In the case of industrial applications, we expect our products to be protected from hazardous or
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Safety Instructions

Qualified personnel must transport, assemble, install, and maintain this equipment. Properly qualified
personnel are persons who are familiar with the transport, assembly, installation, and operation of
equipment. The qualified personnel must know and observe the following standards and regulations:

IEC364resp.CENELEC HD 384 or DIN VDE 0100
IEC report 664 or DIN VDE 0110
National regulations for safety and accident prevention or VBG 4

Incorrect handling of products can result in injury and damage to persons and machinery. Strictly adhere
to the installation instructions. Electrical safety is provided through a low-resistance earth connection. It
is vital to ensure that all system components are connected to earth ground.

This product contains components that are sensitive to static electricity and can be damaged by incorrect
handling. Avoid contact with high insulating materials (artificial fabrics, plastic film, etc.). Place the
product on a conductive surface. Discharge any possible static electricity build-up by touching an
unpainted, metal, grounded surface before touching the equipment.

Keep all covers and cabinet doors shut during operation. Be aware that during operation, the product has
electrically charged components and hot surfaces. Control and power cables can carry a high voltage,
even when the motor is not rotating. Never disconnect or connect the product while the power source is
energized to avoid electric arcing.

A Warning identifies hazards that could result in personal injury or
death. It precedes the discussion of interest.

Warning

A Caution identifies hazards that could result in equipment damage. It
precedes the discussion of interest.

Caution

A A Note identifies information critical to the understanding or use of
& the equipment. It follows the discussion of interest.

Note
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INTRODUCTION

The ACC-24M2A is a two (2) axis servo peripheral designed to work with
Turbo PMAC2 Ultralite, Power PMAC EtherLite, or UMAC MACRO
controllers to remotely interface to two (2) channels of analog style amplifiers.
This device produces a + 10 V. control signal to control analog amplifiers.

The ACC-24M2A can process the following feedback types:
e Quadrature
e 1Vpp Sinusoidal
e Resolver
o SSI

/
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Introduction
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SPECIFICATIONS

Part Number

ACC-24M2A @

©O

4 - 3 7 4 4 - 0 0 - 0 0

0 0 0

() (=)

A - Fiber-Optic MACRO Transceiver

0 - Standard Quadrature Encoder Feedback

C - RJ-45 MACRO Connector 3 - Quadrature Encoder Feedback and
Two channels of sinusoidal, Resolver,
Two channels of SSI Encoder Feedback

MACRO Communication Options

MACRO Node Options
* If Any Additional Option is required, contact factory for digits K and L (Factory Assigned digits).

00

00 - No Additional* Options
Xxx - Factory assigned digits
for Additional* Options

Factory Assigned Options

ACC-24M2A Options

ACC-24M2A may be ordered equipped with the following options:

Options Included

Part Number

2-axis MACRO Analog Servo Peripheral With
Fiber-optic MACRO connectors (Opt-A Included)

4-3744-00-A000-00000

2-axis MACRO Analog Servo Peripheral With
RJ-45 isolated electrical MACRO connectors (Opt-C Included)

4-3744-00-C000-00000

2-axis MACRO Analog Servo Peripheral With
Fiber-optic MACRO connectors (Opt-A Included)
Two channels of sinusoidal, Resolver (Opt-3 Included)
Two channels of SSI Encoder Feedback

4-3744-00-A003-00000

2-axis MACRO Analog Servo Peripheral With
RJ-45 isolated electrical MACRO connectors (Opt-C Included)
Two channels of sinusoidal, Resolver (Opt-3 Included)
Two channels of SSI Encoder Feedback

4-3744-00-C003-00000

Specifications

10
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Environmental Specifications

Description Unit Specifications
Operating Temperature °C +0 to 45°C
Rated Storage Temperature °C -25t0 +70
Humidity % 10% to 90% non-condensing
Shock Call Factory
Vibration Call Factory
Operating Altitude Feet (Meters) | To 3300 feet (1000meters)
Air Flow Clearances in (mm) 1" (2.54mm) above and below unit for air flow

Electrical Specifications

Main Input Power | Nominal Input Voltage (\Vdc) 24 V¢
DAC Output (Vg) +/- 10 Vg
DAC Output (A) 0.045A

Output Power

Flag Output (V)

12-24V 4. Standard, 5 V4. w/ RP38 Installed

Flag Input (Vq)

12-24V 4. Standard, 5 V4. w/ RP38 Installed

Note

Installing a 1 KQ resistor pack at RP38 will make the flags 5 V.

Physical Specifications

Width

Height

Depth

Overall Dimensions

2.00in./50.8mm

9.75in./ 247.7mm

6.50in./ 165.1mm

Mounting Dimensions

1.25in./31.75mm

9.375in./ 238.13mm

Weight: 2.3 Ibs / 1.0 kg

See the “Layout” section of this manual for drawings of the physical layout.

Specifications

11
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RECEIVING AND UNPACKING

Unpacking Guidelines

Delta Tau products are thoroughly tested at the factory and carefully packaged for shipment. When the

ACC-24M2A is received, do the following immediately:

1. Inspect the condition of the shipping container and report any damage immediately to the commercial
carrier that delivered the drive.

2. Remove the device from the shipping container and remove all packing materials. Check all shipping
material for connector kits, documentation, diskettes, CD ROM, or other small pieces of equipment.
Be aware that some connector kits and other equipment pieces may be quite small and can be
discarded accidentally if care is not used when unpacking the equipment. The container and packing
materials can be retained for future shipment.

3. Electronic components in this device are design-hardened to reduce static sensitivity. However, use
proper procedures when handling the equipment.

4. If ACC-24M2A is to be stored for several weeks before use, be sure that it is stored in a location that
conforms to published storage humidity and temperature specifications stated in this manual.

Use of Equipment

The following guidelines describe the restrictions for proper use of ACC-24M2A:

e The components built into electrical equipment or machines can be used only as integral components
of such equipment.

e ACC-24M2A must not be operated on power supply networks without a ground or with an
asymmetrical ground.

e ACC-24M2A may be operated only in a closed switchgear cabinet, taking into account the ambient
conditions defined in the environmental specifications.

Delta Tau guarantees the conformance of ACC-24M2A with the standards for industrial areas stated in
this manual only if Delta Tau components (cables, controllers, etc.) are used.

Receiving and Unpacking 12
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MOUNTING

Installation Guidelines

This product should be installed in an area that is protected from direct sunlight, corrosives, harmful gases
or liquids, dust, metallic particles, and other contaminants. Exposure to these can reduce the operating
life and degrade the performance.

A couple other factors to evaluate carefully when selecting a location for installation:

e Allow for at least 1 inch (2.54mm) top and bottom clearance to permit airflow. At least 0.4 inches
(10mm) clearance is required between each side.

e Temperature, humidity and vibration specifications should also be considered.

ACC-24M2A can be mounted with a 3-hole panel mount, two U-shape notches on the bottom and one
pear-shaped hole on top. Mounting is also identical to this on all peripheral devices.

If multiple MACRO devices are used, they can be mounted side-by-side, leaving at least a 0.4 inch
clearance between them. It is important that the airflow is not obstructed by the placement of conduit
tracks or other devices in the enclosure.

ACC-24M2A should be mounted to an unpainted, electrically-conductive panel in order to allow for
reduced electrical noise interference. The back panel should be machined to accept the mounting bolt
pattern of the accessory. Make sure that all metal chips are cleaned up before the device is mounted so
that there is no risk of getting metal chips inside the device.

ACC-24M2A is mounted to the back panel with three M4 screws and internal-tooth lock washers. The
teeth of the washers must break through the device’s anodizing in order to provide an electrically-
conductive path in as many places as possible.

Units must be installed in an enclosure that meets the environmental
IP rating of the end product (ventilation or cooling may be necessary

. to prevent enclosure ambient from exceeding 45° C [113° F]).
Caution

Installation of electrical control equipment is subject to many

regulations including national, state, local, and industry guidelines

and rules. General recommendations can be stated but it is

important that the installation be carried out in accordance with
WARNING all regulations pertaining to the installation.

Mounting 13
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Connector Locations

Below is a drawing of the product with its connectors labeled:

J12 encoder]
Chan 2@

J6
Flags
1&2

Option-A
MACRO
FIBER

Option-B
MACRO
RJ45

Mounting

14
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CONNECTOR PINOUTS

J10: 24 Vpc Logic Power Input

An external 24VDC power supply is required to power the logic, flags and DAC output sections of ACC-
24M2A through the J10 connector. The polarity of this connection is extremely important. Carefully

follow the instructions in the wiring diagram. This connection can be made using 16 AWG wire directly
from a protected power supply. In situations where the power supply is shared with other devices, it may

be desirable to insert a filter in this connection.

The power supply providing this 24V must be capable of providing an instantaneous current of at least
1.5A to be able to start the DC-to-DC converter in ACC24M2A. In the case where multiple devices are
driven from the same 24V supply, it is recommended that each device be wired back to the power supply
terminals independently. It is also recommended that the power supply be sized to handle the

instantaneous inrush current required for each device.
J10: 3-Pin Edge Connector
Mating: Plated Pins on ACC-24M2A PCB
Pin # Symbol Function Description Notes
1 24VDC RET Common Logic power return
2 +24VDC Input Logic power input 24V £10%, 2 A
3 N.C. N.C. Not Connected

Connector is located at the bottom side of the unit.
Delta Tau part number: 014-188305-001
Phoenix part number: 1883051

Connector Pinouts

15
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J1: Amplifier Channel 1

J1: DB-15 Female
Mating: DB-15 Male

ONORORONONXOROREY
© @G © O e

Pin # Symbol Description
1 DAC1_A+ Phase A +analog output
2 DAC1 B+ Phase B +analog output
3 AE NC 1 Amplifier Enabled Normally Closed
4 AE_NO_ 1 Amplifier Enabled Normally Open
5 AFAULT _1- Amplifier Fault input
6 N.C. Do not connect
7 A+12V Analog Positive Supply Voltage
8 AGND Analog Ground
9 DAC1 A- Phase A +analog output
10 DAC1 B- Phase B +analog output
11 AE_COM_1 Amplifier Enable Common
12 AFAULT 1+ Amplifier Fault input
13 N.C. Do not connect
14 AGND Analog Ground
15 A-12V Analog Negative Supply Voltage

J2: Amplifier Channel 2

J1: DB-15 Female
Mating: DB-15 Male

ONORORONOXOROXE)
BB ® O e

Pin # Symbol Description
1 DAC2_ A+ Phase A +analog output
2 DAC2 B+ Phase B +analog output
3 AE NC 2 Amplifier Enabled Normally Closed
4 AE NO 2 Amplifier Enabled Normally Open
5 AFAULT 2- Amplifier Fault input
6 N.C. Do not connect
7 A+12V Analog Positive Supply Voltage
8 AGND Analog Ground
9 DAC2_A- Phase A +analog output
10 DAC2 B- Phase B +analog output
11 AE COM 2 Amplifier Enable Common
12 AFAULT 2+ Amplifier Fault input
13 N.C. Do not connect
14 AGND Analog Ground
15 A-12V Analog Negative Supply Voltage

Connector Pinouts

16
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J6: Flags and Limits

J6: DB-15 Female
Mating: DB-15 Male

OXORORONONORORE
G ® O e

Pin # Symbol Direction Description
1 USER1 Input User Flag for Channel 1
9 PLIM1 Input Positive Position Limit for Channel 1
2 NLIM1 Input Negative Position Limit for Channel 1
10 HOME1 Input Home flag for Channel 1
3 FLG_RTN1 Input Voltage return for Channel 1’s flags
11 EQU1 Output Position Compare Output for Channel 1
4 USER?2 Input User Flag for Channel 2
12 PLIM2 Input Positive Position Limit for Channel 2
5 NLIM2 Input Negative Position Limit for Channel 2
13 HOME?2 Input Home flag for Channel 2
6 FLG_RTN2 Input Voltage return for Channel 2’s flags
14 EQU2 Output Position Compare Output for Channel 2
7 GND Input Digital Ground
15 GND Input Digital Ground
8 GND Input Digital Ground

Connector Pinouts

17
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J11 & J12: Encoder Feedback, Digital A Quad B

ACC-24M2A accepts inputs from two digital encoders and provides encoder position data to PMAC. J11
is for Encoder 1 and J12 is for Encoder 2. The ACC-24M2A’s encoder interface circuitry employs
differential line receivers. The differential format provides a means of using twisted pair wiring that
allows for better noise immunity when wired into machinery.

J11 & J12: D-sub DB-25F @@@@@@@@@@@
Mating: D-sub DB-25M @@@@@@
Pin # Symbol Description
1 ChA+ Channel A Positive Signal
14 ChA- Channel A Negative Signal
2 ChB+ Channel B Positive Signal
15 ChB- Channel A Negative Signal
3 ChC+ Channel C Positive Signal
16 ChC- Channel C Negative Signal
12/ 24* ENCPWR/5V Encoder Power (+5VDC)
13/25 GND Digital Ground

Note:

e Do not connect the pins that are not listed.

o *|f the encoder being used required +5VDC power, it can be connected to pins 12/24, and grounded on pins
13/25. However, if the encoder has different power requirements, do not connect pins 13/24 and 13/25 to
the encoder.

e Totwist the ENCPWR/5V and the GND wires together is recommended for better noise immunity.

o Tie together the ACC-24M2A’s GND and the encoder’s power supply GND if an external power supply is
used for the encoder for better noise immunity.

Most applications use pin 12 to supply power to the encoder.

However, for encoders that send out initial information at power on,
(fo=a the user should use pin 24 instead of pin 12, and then set M1984=1 on

ACC-24M2A in order to manually enable the encoder power after
Note PMAC is powered on.

Connector Pinouts 18
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J11 & J12: Encoder Feedback, SSI

ACC-24M2A accepts inputs from two digital encoders and provides encoder position data to PMAC. J11
is for Encoder 1 and J12 is for Encoder 2. The ACC-24M2A’s encoder interface circuitry employs
differential line receivers. The differential format provides a means of using twisted pair wiring that

allows for better noise immunity when wired into machinery.

J11 & J12: D-sub DB-25F
Mating: D-sub DB-25M

EXCR O TRONOXOROXORONOXOREY

P0G

Pin # Symbol Description
6 CLK+ Serial Clock Signal Positive
7 DATA+ Serial Data Signal Positive
19 CLK- Serial Clock Signal Negative
20 DATA- Serial Data Signal Negative
12/24* ENCPWR/5V Encoder Power (+5VDC)
13/25 GND Digital Ground

Note:

e Do not connect the pins that are not listed.
o *|f the encoder being used required +5VDC power, it can be connected to pins 12/24, and grounded on pins

13/25. However, if the encoder has different power requirements, do not connect pins 13/24 and 13/25 to

the encoder.

e Totwist the ENCPWR/5V and the GND wires together is recommended for better noise immunity.
o Tie together the ACC-24M2A’s GND and the encoder’s power supply GND if an external power supply is
used for the encoder for better noise immunity.

Most applications use pin 12 to supply power to the encoder.

the user should use pin 24 instead of pin 12, and then set M1984=1 on

However, for encoders that send out initial information at power on,
A@

ACC-24M2A in order to manually enable the encoder power after
Note PMAC is powered on.

Connector Pinouts

19
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J11 & J12: Encoder Feedback, Sinusoidal

ACC-24M2A accepts inputs from two digital encoders and provides encoder position data to PMAC. J11
is for Encoder 1 and J12 is for Encoder 2. The ACC-24M2A’s encoder interface circuitry employs
differential line receivers. The differential format provides a means of using twisted pair wiring that
allows for better noise immunity when wired into machinery.

Acc-24M2A with the Sinusoidal Interpolator option accepts inputs from two sinusoidal or quasi-
sinusoidal encoders and provides encoder position data to the motion processor. This interpolator creates
4,096 steps per sine-wave cycle. The user must order the appropriate option. ACC-24M2A can be used
only with a voltage mode sinusoidal encoder type.

Be sure to use shielded, twisted pair cabling for sinusoidal encoder wiring. Double insulated is the best
choice. The sinusoidal signals are very small and must be kept as noise free as possible. Avoid cable
routing near noisy motor or driver wiring. Refer to the appendix for tips on encoder wiring.

It is possible to reduce noise in the encoder lines of a motor-based system by the use of inductors that are
placed between the motor and the amplifier. Improper grounding techniques may also contribute to noisy
encoder signals.

J11 & J12: D-sub DB-25F @@@@@@@@@@@
Mating: D-sub DB-25M @@@@@@
Pin # Symbol Description
1 Sin+ Sinusoidal Signal Positive
14 Sin- Sinusoidal Signal Negative
2 Cos+ Cosine Signal Positive
15 Cos- Cosine Signal Negative
3 Index+ Index Pulse Signal Positive
16 Index- Index Pulse Signal Negative
12/24* ENCPWR/5V Encoder Power (+5VDC)
13/25 GND Ground

Note:

e Do not connect the pins that are not listed.

e *|f the encoder being used required +5VDC power, it can be connected to pins 12/24, and grounded on pins
13/25. However, if the encoder has different power requirements, do not connect pins 13/24 and 13/25 to
the encoder.

e Totwist the ENCPWR/5V and the GND wires together is recommended for better noise immunity.

o Tie together the ACC-24M2A’s GND and the encoder’s power supply GND if an external power supply is
used for the encoder for better noise immunity.

Most applications use pin 12 to supply power to the encoder.
However, for encoders that send out initial information at power on,
the user should use pin 24 instead of pin 12, and then set M1984=1 on
ACC-24M2A in order to manually enable the encoder power after
Note  pMAC is powered on.

Connector Pinouts 20



Accessory 24M2A

J11 & J12: Encoder Feedback, EnDat

The Acc-24M2A will read the absolute data from the EnDat (Encoder Data) interface only if the
appropriate option is ordered. Its differential format provides a means of using twisted-pair wiring that
allows for better noise immunity when wired into machinery.

J11 & J12: D-sub DB-25F @@@@@@@@®@@
Mating: D-sub DB-25M @ @ @ @ @ @

Pin # Symbol Description
1 Sin+/ ChA+ Sinusoidal Signal Positive/Channel A Positive
2 Cos+/ChB+ Cosine Signal Positive/Channel B Positive
14 Sin-/ChA- Sinusoidal Signal Negative/Channel A Negative
15 Cos-/ChB- Cosine Signal Negative/Channel B Negative
6 CLK+ Clock Signal Positive
7 DATA+ Data Signal Positive
19 CLK- Clock Signal Negative
20 DATA- Data Signal Negative

12/24 ENCPWR/5V Encoder Power (+5VDC)

13/25 GND Ground

Note:

e Do not connect the pins that are not listed.

o *|f the encoder being used required +5VDC power, it can be connected to pins 12/24, and grounded on pins
13/25. However, if the encoder has different power requirements, do not connect pins 13/24 and 13/25 to
the encoder.

e Totwist the ENCPWR/5V and the GND wires together is recommended for better noise immunity.

o Tie together the ACC-24M2A’s GND and the encoder’s power supply GND if an external power supply is
used for the encoder for better noise immunity.

Most applications use pin 12 to supply power to the encoder.

However, for encoders that send out initial information at power on,
= the user should use pin 24 instead of pin 12, and then set M1984=1 on

ACC-24M2A in order to manually enable the encoder power after
Note  pMAC is powered on.
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J11 & J12: Encoder Feedback, HiperFace

ACC-24M2A will read the absolute data from the Hiperface® interface only if the appropriate option is

ordered.

J11 & J12: D-sub DB-25F
Mating: D-sub DB-25M

EXCRONDRONOXOROXORONOXOREY
PO OGO®

Pin # Symbol Description
1 Sin+/ ChA+ Sinusoidal Signal Positive/Channel A Positive
2 Cos+/ChB+ Cosine Signal Positive/Channel B Positive
14 Sin-/ChA- Sinusoidal Signal Negative/Channel A Negative
15 Cos-/ChB- Cosine Signal Negative/Channel B Negative
7 DATA+ Clock Signal Positive
20 DATA- Data Signal Positive

12/24 ENCPWR/5V Clock Signal Negative

13/25 GND Data Signal Negative

Note:

e Do not connect the pins that are not listed.
o *|f the encoder being used required +5VDC power, it can be connected to pins 12/24, and grounded on pins
13/25. However, if the encoder has different power requirements, do not connect pins 13/24 and 13/25 to

the encoder.

e Totwist the ENCPWR/5V and the GND wires together is recommended for better noise immunity.
o Tie together the ACC-24M2A’s GND and the encoder’s power supply GND if an external power supply is
used for the encoder for better noise immunity.

Most applications use pin 12 to supply power to the encoder.

the user should use pin 24 instead of pin 12, and then set M1984=1 on

However, for encoders that send out initial information at power on,
A@‘

ACC-24M2A in order to manually enable the encoder power after
Note PMAC is powered on.

A As of the date of the latest revision of this manual, HiperFace is not
B yet part of the ACC-24M2A firmware.

Note

Connector Pinouts
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J11 & J12: Encoder Feedback, Resolver

The ACC-24M2A can interface to most industry standard resolvers if the appropriate option is ordered.
Typical resolvers requiring 5 to 10 kHz excitation frequencies with voltages ranging from 5 to 10 V peak-
to-peak are compatible with this drive.

Fundamentally, the ACC-24M2A connects three differential analog signal pairs to each resolver: a single
excitation signal pair, and two analog feedback signal pairs. The wiring diagram below shows an
example of how to connect the ACC-24M2A to the Resolver.

The differential format provides a means of using twisted pair wiring that allows for better noise
immunity when wired into machinery.

Jll&JlZ:D-subDB-ZSF @@@@@@@@@@@
Mating: D-sub DB-25M @ @ @ @ @ @

Pin # Symbol Description
4 ResSin+ Resolver Sine Positive
17 ResSin- Resolver Sine Negative
5 ResCos+ Resolver Cosine Positive
18 ResCos- Resolver Cosine Negative
11 ResOut Resolver Output
13/25 GND GND

Note:

e Do not connect the pins that are not listed.

o *|f the encoder being used required +5VDC power, it can be connected to pins 12/24, and grounded on pins
13/25. However, if the encoder has different power requirements, do not connect pins 13/24 and 13/25 to
the encoder.

To twist the ENCPWR/5V and the GND wires together is recommended for better noise immunity.
Tie together the ACC-24M2A’s GND and the encoder’s power supply GND if an external power supply is
used for the encoder for better noise immunity.

Most applications use pin 12 to supply power to the encoder.
However, for encoders that send out initial information at power on,
the user should use pin 24 instead of pin 12, and then set M1984=1 on
ACC-24M2A in order to manually enable the encoder power after
Note PMAC is powered on.
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Universal Serial Bus Port (USB Port)

This connector uses a USB A-B cable to establish communication between the PC and the ACC-24M2A.
This type of USB cable could be purchased at any local electronics or computer store. It may be ordered
from Delta Tau as well.

Pin # Symbol Function
1 VCC N.C.
2 D- DATA-
3 D+ DATA+
4 GND GND
5 SHELL SHIELD
6 SHELL SHIELD

This connector is used only to change the operational firmware, or to perform basic software diagnostic
operations. The user can use a serial port terminal window such as Microsoft® HyperTerminal to
communicate with the MACRO Device and send ASCII commands to the device. Set the serial port
communication settings as follows:

Baud Rate: 38400 if E3 is not jumpered, or 9600 if E3 is jumpered
Data Bits: 8

Parity: None

Stop Bits: 1

Flow Control: Xon/Xoff

If the PeWin32PRO2 software is installed on the PC, then the USB device should be recognized by the
operating system. If the device is not recognized, then contact Technical Support for assistance.
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MACRO Fiber Connector

Option A provides the following connector for MACRO communications:

ouT IN
MACRO SC-Style Fiber Connector ]@[ ]@[
Front View
Pin # Symbol Function
1 IN MACRO Ring Receiver
2 ouT MACRO Ring Transmitter

Notes: The fiber optic version of MACRO uses 62.5/125 multi-mode glass fiber optic cable terminated in an SC-style connector.

The optical wavelength is 1,300 nm.

The input connector must be inserted into the MACRO output connector of the previous device on the
MACRO ring. The output connector must be inserted into the input MACRO connector of the next

device on the MACRO ring.

MACRO RJ-45 Copper Connector

Option C Provides the following connector for MACRO communications:

ouT IN
Connector: RJ45 CAT5e
Mating: RJ45 Receptacle
Front View
Pin # Symbol Function  |Description

1 DATA+ Data + Differential MACRO Signal
2 DATA- Data - Differential MACRO Signal
3 Unused Unused terminated pin
4 Unused Unused terminated pin
5 Unused Unused terminated pin
6 Unused Unused terminated pin
7 Unused Unused terminated pin
8 Unused Unused terminated pin

The cable used for MACRO wired connections is CATS5 verified straight-through 8 conductor.

The input connector must be inserted into the MACRO output connector of the previous device on the
MACRO ring. The output connector must be inserted into the input MACRO connector of the next

device on the MACRO ring.

Connector Pinouts
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Sample Wiring Diagrams

J6: Flags
Sourcing Flags Sinking Flags
Oor 12-24 VvDC 5o0r 12-24 VDC
Power Supply Power Supply
() g 8 S 8
C)—m—/o— B C%m—/%
O A CEEED O =2 CmmD
@% O+——mo—o
@@ —— (:P®m/%
@@m—/o— C>—®—CMIIME)—O/07
O = axmD O D
GO Do o GO+cCmrDo-o
Oz Op
o2 %
\/ \/
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Output IC Diagram
ACC-24M2A allows the use of sinking or sourcing position limits and flags to the controller. The opto-
isolator 1C used is a PS2705-4NEC-ND quad phototransistor output type (see below).

+5V
RETURN
* ANN—
To
PMAC
2 WANERV/
GND | FL.AG

This IC allows the current to flow from return to flag (sinking) or from flag to return (sourcing).

A sample of the internal positive limit circuit for this IC is shown below.

Digital Analog

Plone Plana
|

PLIM= 1% | L 4. 7K FLIM
g
GO 11 | &
-
1K

| o

| PE2VOS—ANEG—ND {Surfoce kounted)
PS2505—4NEC—HD [Socketad)

The 4.7K resistor packs used will allow 12-24V flag inputs. If the user wants to use 0-5V flags, then a

1KQ resistor pack (RP) can be placed in RP7 for Channel 1’s flags or in RP8 for Channel 2’s flags. If

these resistor packs are not added, all flags (+ Limits, Home, User, and Amplifier Fault) will be
referenced from 12-24V.
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J11 & J12: Encoder Feedback, Digital A Quad B

The following wiring diagram shows an example of how to connect a quadrature encoder:

f

J11 & J12: Encoder Feedback, SSI

“CHA+———
, Of—CHA-
&——1CHB+
O-——CHB-
%*CHCCJC Quadrature
& T Encoder
17
s O
O
O
S L Shield
7
D a
é 21
O
6 22
10 O
O 23
w Ol 5V
O 24
12
O-ogr GND
13
O
@ 15
O
@ 16
@ 17
© 4
h
& CLK+ "l
CLK-
O— DAT+ - SSi
O DAT- encoder
& mu /g
® /
10 6 ""\ Shield
O 23
11 O +5V
O 24
O____
1 GND
S-5
13
O
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J11 & J12: Encoder Feedback, Sinusoidal

Differential Format

The differential format provides a means of using twisted pair wiring that allows for better noise

immunity when wired into machinery.

Single Ended Format 1

%*SIN+ N
, Ol __SIN-
O 15 vOS"’
, O-f—Cos-
O—(ls}lNl?&éEX Sinusoidal
A ] Encoder
17
O
6 5 p N/
& Shield
19
7
O 20
O
é 21
O
6 22
10 Q
O 23
u O 9V
O 24
O R
2o = ' GND
25
13
O

The single-ended formats provide a simpler means of using a sinusoidal encoder. Typically, fewer wires
are needed and the encoders are always of the lower impedance voltage output type.

. A
Note that all the single-ended encoder formats shown

N Encoder Output [V]

AWA

here might have velocity-ripple effects at very slow +3.0Vpk
speeds due to the effects of op-amp voltage offsets.
These offsets cause the sinusoidal signal to be centered .
at a value that is slightly different from the reference or +25Vde
servo ground as shown in the signal diagram on the right:

+2.0Vpk

\/ \ Time [s]
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Below is the wiring diagram for Single Ended Format 1:

— SIN+ —
— COS+ —

— INDEX+ —

| REV |
2.5V

Single Ended Format 2

O Oz Oo O= O Qo On O= O» Ov [

-
N

=
w

]

-
I

— SIN-

— COS-

Enco

Sinusoidal

der

The diagram shown below is a simple single-ended encoder-wiring interface for encoders with output
range at 2-3 VVdc. This encoder has SIN and COS outputs that provide a 1V peak-to-peak output with a
voltage offset of 2.5 Vdc. Note that the SIN+, COS+, and INDEX+ lines are tied to the 2.5V internal

references on the interpolator card.

The diagram to the right is similar to the signal diagram from 1

the Single Ended Format 1 but with a different voltage offset.

N Encoder Output [V]

+0.5Vpk

This encoder has SIN and COS outputs that provide a 1V peak-

to-peak output with a voltage offset of 0.0 Vdc. Note that the 0 Vde
SIN-, COS-, and INDEX- lines are tied to the GND on the

interpolator card, and the encoder usually requires a bipolar

supply.

AWA

-0.5\ipk

\/ \ Time [s]
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The wiring diagram for Single Ended Format 2 is below:

! \
STV (N P
, Of— SIN- ——
- COS+ —O 15
, O cos-
»- INDEX+ O L — Sinusoidal
A } Encoder
17
O
é 18 N
6 o Shield
<1)9
S L
O
é 21
O
é 22
10 O
O 23
B 2 GND
GND . O
3 GND
13

Noise Problems

When problems do occur, the culprit is often electrical noise. When this occurs, attempt to control the
high-frequency current paths. If following the grounding instructions does not work, insert chokes in the
motor phases. These chokes can be as simple as several wraps of the individual motor leads through a
ferrite ring core (such as Micrometals T400-26D). This adds high-frequency impedance to the outgoing
motor cable thereby impeding high-frequency noise from leaving the control cabinet. Care should be
taken to be certain that the core’s temperature is in a reasonable range after installing such devices.
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J11 & J12: Encoder Feedback, EnDat

EnDat Interface

[,
@
® .' U 1Vpp A
@ -
© «— v 1Vpp B
® —» Up Power
—» OV Supply
@
> DATA
< DATA
® —» CLOCK
10 —» CLOCK
O
11
O
12
O—=7
13

J11 & J12: Encoder Feedback, HiperFace

Hiperface® Interface

]
o
5

/

Sin+
Sin
Cos+

~
Cos

®

: ~o 1Vpp A

o v 1Vpp B

—» Up Power
—» OV Supply

Q @ ©® & @

DATA

ol <> DATA

<> DATA

Hiperface Int¢rface

©)
@z Os Or 08| Os Os Os Os Qg Q

Os @

In_Therm_Mot—

.
=

O

.
Y

Qs O
L4
[0}
g

\

A As of the date of the latest revision of this manual, HiperFace is not
yet part of the ACC-24M2A firmware.

Note

Connector Pinouts



Accessory 24M2A

J11 & J12: Encoder Feedback, Resolver

Resolver

Twisted pair Screened
Cable

Notes:
Terminate shields on pins 13 and 25

ACC-24M2A

ResSin+—
I ResSin-—

A |
\

l
I
)
|

|
l |
\rShieId C\;GNN%_

—ResCos+
ResCos-.1

:

uié»owon:
5 Os Os Ox

ié

Oe

O O Os O» O~
Orp O O Ox Os Oz

[
N

ti O

\
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TROUBLESHOOTING

Status LED Indicators

Status Display Color Description

7-segment LED Red 16 numeric codes plus two decimal points
PWR Green Lit when logic power is good
WD Red Indicates that the watchdog safety circuit has

activated, indicating a failure condition.

7-Segment LED Indicator

This indicator reports the status of the unit with respect to the MACRO link, indicating the value of
MI974. These are the possible status codes:

7-Segment LED

5082-7730
Display Description Notes/Cause
0 Ring Active with no errors Normal Operation with decimal point blinking

1 One (1) Amp Enable output

activated

If an amplifier/motor is connected, it is potentially
activated in either open or closed loop form. Exercise
caution.

2 Two (1) Amp Enable outputs

If an amplifier/motor is connected, it is potentially

activated activated in either open or closed loop form. Exercise
caution.
3-9 NA NA

A Amplifier Fault

Denotes Amplifier fault condition true. Cleared by
enabling amplifier or CLRF.

B MACRO Ring Break Fault

Break or misconnection in fiber optic or RJ45 ring
termination.

C Configuration change fault

Denotes mismatch between master and slave node
configuration. Check M1996 and 16806, etc. for match.
Clear with CLRF.

D MACRO Ring Fault

Ring Data-Error Fault. Too many ring errors or not
enough synch packets being received. Node 15 may not
be properly enabled.

E Encoder Fault

Encoder Loss bit condition true (M1927=1). Occurs
only when Encoder Loss detection is enabled. Denotes
loss of encoder signal. Check encoder wiring and
functionality.

NA

Troubleshooting
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CONFIGURING WITH TURBO PMAC

Quick Review: Nodes and Addressing

Each MACRO IC consists of 16 nodes: 2 auxiliary, 8 servo, and 6 1/0 nodes.
e Auxiliary nodes are Master/Control registers and internal firmware use.
e Servo nodes carry information such as feedback, commands, and flags for motor control.
e 1/0O nodes are by default unoccupied and are user configurable for transferring miscellaneous data.

1/0 Nodes
3
Node | 15|14 (13|12 |11(10| 9 ( 8 [ 7 | 6 | 5| 4 | 3 | 2 110
T 7
Auxiliary
Nodes Servo Nodes

Each 1/0 node consists of 4 registers; one 24-bit and three 16-bit registers for a total of 72 bits of data.

13 | 12 11 10 918 7 6 51| 4 <) 2 110
24-bit 24-bit 24-bit 24-bit 24-bit 24-bit
1* 16-bit | 1> 16-bit 1° 16-bit | 1> 16-bit 1* 16-bit | 1> 16-bit
2" 16-bit | 2" 16-bit 2" 16-bit | 2" 16-bit 2" 16-bit | 2" 16-bit
3 16-bit | 3" 16-bit 3 16-bit | 3" 16-bit 3 16-bit | 3" 16-bit
A given MACRO Station can be populated with either a MACRO8 or MACRO16 CPU:
e MACROS supports only 1 MACRO IC (IC#0).
e MACROL16 supports 2 MACRO ICs (IC#0 and IC#1).
The 1/0 node addresses ($C0XX) for each of the Station MACRO ICs are:
Station MACRO IC #0 Node Registers
Node 2 3 6 7 10 11
24-bit | X:$CO0A0 X:$CO0A4 X:$COA8 X:$COAC X:$C0B0 X:$C0B4
16-bit | X:$C0AL X:$COA5 X:$CO0A9 X:$COAD X:$C0B1 X:$C0B5
16-bit | X:$C0A2 X:$COA6 X:$COAA X:$COAE X:$C0B2 X:$C0B6
16-bit | X:$C0A3 X:$COA7 X:$COAB X:$COAF X:$C0B3 X:$C0B7
Station MACRO IC #1 Node Registers
Node 2 3 6 7 10 11
24-bit | X:$COEQ X:$COE4 X:$COE8 X:$COEC X:$COF0 X:$COF4
16-bit | X:$COE1 X:$COE5S X:$COE9 X:$COED X:$COF1 X:$COF5
16-bit | X:$COE2 X:$COE6 X:$COEA X:$COEE X:$COF2 X:$COF6
16-bit | X:$COE3 X:$COE7 X:$COEB X:$COEF X:$COF3 X:$COF7
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Note

Non-Turbo PMAC?2 Ultralite (legacy) 1/0 node addresses are the same
as Station MACRO IC#0 node registers.

A given Turbo PMAC?2 Ultralite (or UMAC with ACC-5E) can be
populated with up to 4 MACRO ICs (IC#0, IC#1, IC#2, and IC#3)

which can be queried with global variable 14902:

If 14902= | Populated
MACRO IC #s

$0 None

$1 0

$3 0,1

$7 0,12

$F 0,123

And the 1/0 node addresses ($7XXXX) for each of the Ultralite MACRO ICs are:

Ring Controller MACRO IC #0 Node Registers

Station 1/0 Node# 2 3 6 7 10 11
Ultralite 1/0O Node# 2 3 6 7 10 11
24-bit X:$78420 | X:$78424 | X:$78428 | X:$7842C | X:$78430 | X:$78434
16-bit X:$78421 | X:$78425 | X:$78429 | X:$7842D | X:$78431 | X:$78435
16-bit X:$78422 | X:$78426 | X:$7842A | X:$7842E | X:$78432 | X:$78436
16-bit X:$78423 | X:$78427 | X:$7842B | X:$7842F | X:$78433 | X:$78437
Ring Controller MACRO IC #1 Node Registers
Station 1/0 Node# 2 3 6 7 10 11
Ultralite 1/0O Node# 18 19 22 23 26 27
24-bit X:$79420 | X:$79424 | X:$79428 | X:$7942C | X:$79430 | X:$79434
16-bit X:$79421 | X:$79425 | X:$79429 | X:$7942D | X:$79431 | X:$79435
16-bit X:$79422 | X:$79426 | X:$7942A | X:$7942E | X:$79432 | X:$79436
16-bit X:$79423 | X:$79427 | X:$7942B | X:$7942F | X:$79433 | X:$79437
Ring Controller MACRO IC #2 Node Registers
Station 1/0 Node# 2 3 6 7 10 11
Ultralite 1/0 Node# 34 35 38 39 42 43
24-bit X:$7A420 | X:$7A424 | X:$7A428 | X:$7A42C | X:$7A430 | X:$7A434
16-bit X:$7A421 | X:$7A425 | X:$7A429 | X:$7A42D | X:$7A431 | X:$7A435
16-bit X:$7A422 | X:$7A426 | X:$7TA42A | X:$7TA42E | X:$7A432 | X:$7A436
16-bit X:$7A423 | X:$7A427 | X:$7A42B | X:$7A42F | X:$7A433 | X:$7A437
Ring Controller MACRO IC #3 Node Registers
Station 1/0 Node# 2 3 6 7 10 11
Ultralite 1/0 Node# 50 51 54 55 58 59
24-bit X:$7B420 | X:$7B424 | X:$7B428 | X:$7B42C | X:$7B430 | X:$7B434
16-bit X:$7B421 | X:$7B425 | X:$7B429 | X:$7B42D | X:$7B431 | X:$7B435
16-bit X:$7B422 | X:$7B426 | X:$7B42A | X:$7B42E | X:$7B432 | X:$7B436
16-bit X:$7B423 | X:$7B427 | X:$7B42B | X:$7B42F | X:$7B433 | X:$7B437

Configuring with Turbo PMAC
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Setup Overview

This setup assumes that the Ring Master has already been properly configured to run its own local
motors.

In order to set up ACC-24M2A with Turbo PMAC, one must:

1. Onthe Ring Master, enable one (if ACC-24M2A will only use one motor) to two (using two
motors) servo nodes (any two unused servo nodes) per ACC-24M2A

Variables involved:
16840/16890/16940/16990 — MACRO IC Ring Configuration/Status
16841/16891/16941/16991 — MACRO IC Node Activate Control

Also, make sure 178 and 180-182 have been properly configured on the Master.

2. Establish communication between the Master and the ACC-24M2A using MACRO ASCII Mode
and enable one or two servo nodes on ACC-24M2A.

Variables involved:

MS{anynode},MI11 MACRO Station Station Number
MS{anynode},M1995 MACRO Ring Configuration/Status
MS{anynode},M1996 MACRO Node Activate Control

Set up Feedback.

Set up Flag and Output Command Registers.
Configure I°T Protection.

Perform an Open Loop Test.

Tune the Servo Loop.

Nook~w
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Setup Step 1. MACRO Connectivity

ACC-24M2A requires that the same number of servo nodes be activated through 16841 as there are
motors being used on ACC-24M2A,; e.g. two servo nodes should be enabled on the Ring Controller if
using two motors, one servo node if using only one motor. 180-182 and 170-171 must also be configured.
There is a specific set of formulas to use for configuring these, as shown in the following example.

Example: Setting up nodes 0 and 1 to control one ACC-24M2A

#define RingCheckPeriod 20 ; Suggested Ring Check Period [msec]

#define FatalPackErr 10 ; Suggested Fatal Packet Error Percentage [%]
I80=INT (RingCheckPeriod *8388607/I10+1) ; Macro Ring Check Period [Servo Cycles]
I81=INT(I80/(I8+1)* FatalPackErr /100) ; Macro Maximum Ring Error Count
I82=INT(I80/(I8+1)* (100-FatalPackErr)/100) ; Macro Minimum Sync Packet Count

I16841=$SFC003 // Enable nodes 0 and 1, MACRO IC 0 is master

16840=5$4030 // MACRO IC 0 transmits clocks

// for 170 and I71, use the formula I70=MI996 & $3333, I171=MI%96 & $3333 //
MSRO,MI996,P33 // Obtain MI996’s value and store it in P33
I70=P33&$3333 // Enable flag transfer for nodes 0 and 1

I71= P33&$3333 // Enable flag transfer for nodes 0 and 1

Before proceeding, type SAVE, and then $$3.
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Setup Step 2: Communicating with ACC-24M2A over MACRO ASCII

ACC-24M2A has no rotary switches to determine its MACRO Station Number. Therefore, ACC-24M2A
uses the Ring Order method to obtain its Station Number. Before the ACC-24M2A has been initialized, it
will by default be at MACRO Station #255.

If ACC-24M2A is not at factory default, the user can reinitialize it as follows:

e If using MACRO IC #0, to reinitialize ACC-24M2A, type MS$$$***15, then MSSAV15, then
MS$$$15.

e If using MACRO IC #1, type MS$$$***31, then MSSAV31, then MS$$$31.

e If using MACRO IC #2, use MS$$$***47, then MSSAV47, then MS$$$47, and so on for other
MACRO IC #s.

Then, establishing communication is as follows:
1. Within PeWin32Pro2, in the Terminal Window, type MACSTA255.

2. Type I11=nin order to assign this ACC-24M2A to Station #n.

A ACC-24M2A must be assigned to any unused Station Number (e.g.
L= 111=1 to assign ACC-24M2A to Station #1).

Note

If a Macro 1/O error is received, make sure 16840, 16841 and 179 are set correctly. Also make sure
that the unit has not been assigned a Station number already.

If the Station has already been assigned a Station number, there are two options:

A. Find out the station number n and enter MACSTA<n>, where n is the station number, to
initiate MACRO ASCII communication with the Station.

B. Reset the station number of all the Stations by entering MACSTAOQ and then enter
STN=0.

3. Hit CTRL+T (T) to exit MACRO ASCII Mode.

4. Type MACSTAnN where n is the Station Number assigned in step 2 (e.g. MACSTAL to open
ASCII communication with Station #1).

5. Assign the node and master number with M1996.
For example, to assign the Station to Nodes 0 and 1 on Master IC #0 on the ACC-24M2A, type:

| MI996=5FC003 |

6. Set M1995=$80.
Example:
| MI1995=580
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7. Hit CTRL+T (~T) to exit MACRO ASCII Mode.

Setup Step 3: Motor Setup

Clocks

For simplicity, set the max phase and clock dividers the same as the ring controller, but note that the servo
rate on the Slave Station is independent and can be set to a different frequency.

MS{anynode},1992= Value of 17000 (or 16800) I/l Max Phase Clock

MS{anynode},1997= Value of 17001 (or 16801) // Phase Clock Divider
MS{anynode},1998= Value of 17002 (or 16802) I/ Servo Clock Divider

A The Phase clock on the MACRO Station must be the same as the Ring
B Controller’s, but the Servo Clock can be different.

Note

Example: When Nodes 0 and 1 are being used for ACC-24M2A, setting default clocks

MSO0,MI992=6527
MS0,MI997=0
MS0,MI998=3

Then, issue MSSAV15 followed by MS$$$15 to save the changes on the Station.

Activating Motors and Disabling Commutation

The user must activate the motor he or she wants to use, and then disable commutation for those motors,
because the ACC-24M2A runs only non-PMAC-commutated motors. On the Ring Controller, the
variable 14900 reports which Servo ICs are present in a Brick, Brick LV, or other Turbo PMAC
controller. Knowing that each Servo IC services 4 axes, querying 14900 will reveal how many local
channels are occupied and thus the number of the 1% available motor on a Macro Ring. The corresponding
Ixx00 (for activating the motor) and Ixx01 (for commutation settings) settings are given in the rightmost
columns:

First
If 14900 Servo ICs Local Motor# Activating Deactivating
Returns Present Motors On The 2-Axis Slave | Commutation
Ring
$0 None None 1 1100,2,100=1 I101,2,100=0
$1 ICO only (4-axis) 1 thru 4 5 1500,2,100=1 1501,2,100=0
$3 IC0, and IC1(8-axis) 1 thru 8 9 1900,2,100=1 1901,2,100=0
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Motor Feedback

First, the user must make Encoder Conversion Table (ECT) entries on the Ring Controller to read the
feedback coming back from the ACC-24M2A on servo nodes. This applies to all feedback types that
ACC-24M2A uses.

Use the ECT entry type Parallel Y-Word, No Filtering, 24 bits wide, No Shifting, No Offset. Make sure to
select the address based on the correct nodes enabled for this ACC-24M2A. One can set up the ECT entry
using PeWin32Pro2 by clicking (from within the software) on Configure->Encoder Conversion Table,
showing this window:

"® Turbo Encoder Conversion Table: Device # 0 [UMAC TUREO]V1.947 ...[ = [ & |[s234]
Select a table entry to viewfedit
+ | End of Table | Download Entry
Entry: 1
- | First Entry of Table |
Cone
Entry  y-$3501 Processed Data  x-43502
Address Address:
View &l Entries of Table |
[Viewing]
Corversion Type: |F'ara||e| paz from 'y word with no filkering j
Source Address, |FREEEN j
Width in Bits: |24 Offzet Location of LSE at Source Address (0
Bazed Index]: 0
Canversion Shifting of Parallel D ata
" Mormal zhift [ bits to the left]
o Mo Shifting

The only field the user needs to change on this screen is the Source Address and the Entry Number. Make
the Source Address the correct address depending on the node to which this ECT entry corresponds.
Make the Entry Number whatever is desired as long as it does not conflict with an ECT entry currently
used for another motor.

Example: Motors 1-2 on Nodes 0 and 1, respectively

I8000=$2F8420 // Unfiltered parallel pos of location Y:$78420, Node 0
I8001=$18000
I18002=$2F8424 // Unfiltered parallel pos of location Y:$78424, Node 1
I8003=$18000

Then, point this motor’s Ixx03 and Ixx04 to the numerical hex value Processed Data Address listed the
ECT window shown above.

Example: Motors 1-2 Ixx03 and Ixx04 setting:

I103=$3502 I104=$3502
I203=$3503 I204=3$3503

The only exception to this would be if the user wants to use dual feedback on ACC-24M2A and is
therefore using both encoder channels for one motor, in which case the user must make one ECT entry for
each encoder and point Ixx03 to the position encoder and 1xx04 to the velocity encoder.
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Digital A Quad B
The user must configure the Encoder Conversion Table on the ACC-24M2A itself as follows:

Example: ACC-24M2A with two motors, one on Node 0, one on Node 1

// ACC-24M2A ECT Setup for Quadrature Encoders
MS0,MI120=$0C090 ; 1/T Extension of Incremental Encoder Chl
MS0,MI121=$0C098 ; 1/T Extension of Incremental Encoder Ch2

// ACC-24M2A ECT Output Setup
MS0,MI101=$10 ; Output from 1°° line of ECT (MI120)
MS0,MI102=$11 ; Output from 2" line of ECT (MI121)

If the user wants to change the direction of the encoder feedback, he or she can either:
e Swap the motor’s leads
e Change MS<node>, MI1910:
If M1910=3, set it to 7 (clockwise rotation is positive)
If M1910=7, set it to 3 (counterclockwise rotation is positive)

Sinusoidal
The user must configure the Encoder Conversion Table on the ACC-24M2A itself as follows:

Example: ACC-24M2A with two motors, one on Node 0, one on Node 1

// ACC-24M2A ECT Setup for Sinusoidal Encoders

// Channel 1

MS0,MI120=$F0C090 // Data Source Address location
MS0,MI121=SFF00 // A/D Converter Address Setup
MS0,MI122=0 // Sine/Cosine Bias

// Channel 2
MS0,MI123=$F0C098 // Data Source Address location
MS0,MI124=SFF20 // A/D Converter Address Setup

MS0,MI125=0 // Sine/Cosine Bias
// ACC-24M2A ECT Output Setup

MS0,MI101=$12 // Output from 3"® line of ECT (MI122)
MS0,MI102=$15 // Output from 6" line of ECT (MI125)

Note that the third line of the entry for each channel (in this example, M1122 for Channel 1 and M1124 for
Channel 2) contains the bias in the A/D converter values. This line should contain the value that the A/D
converters report when they should ideally report zero. The MACRO Station subtracts this value from
both A/D readings before calculating the arctangent. Many users will leave this value at 0, but it is
particularly useful to remove the offsets of single-ended analog encoder signals. If it appears that the
encoder has an offset, the user can compensate for it in these variables. This line is scaled so that the
maximum A/D converter reading provides the full value of the 24-bit register (+/-2%). Generally, it is set
by reading the A/D converter values directly as 24-bit values (in this example, from Y:$C090 for Channel
1 and from Y:$C098 for Channel 2), computing the average value over a cycle or cycles, and entering this
value here.

For more detail on how the Sinusoidal Interpolation works in PMAC, see Appendix D.

motor/encoder shaft by hand and see encoder counts in the position

At this point of the setup process, you should be able to move the
=
window

Note
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SSI

ACC-24M2A can be configured to process SSI encoder feedback as a binary parallel word in 12, 16, 20,
or 24-bit format. As with all feedback, this data is transferred across the MACRO ring to be used as
position and/or velocity feedback. Each SSI device requires three lines of the ECT.

In the second line of each SSI ECT entry, the number of bits to process is specified. So, there are four
examples given below.

In the third line, specify the maximum change per servo cycle of the encoder counts that is expected. This
is typically equal to 1.25 times the maximum expected velocity of the motor. The units of this entry

are whatever the units of the input register are, typically 1/32 of a count. For example, to limit the change
in one servo cycle to 64 counts with an input register in units of 1/32 count, this third line would be 64*32
=2048.

In the examples below, the user must specify the maximum count change per servo cycle on the lines
which end with “-User Input” in the comments.

Example: ACC-24M2A with two motors, each with a 12-bit SSI encoder, one on Node 0, one on
Node 1

#define MaxVelChl 0 // Maximum count change per servo cycle, Channel 1 -User Input
#define MaxVelCh2 0 // Maximum count change per servo cycle, Channel 2 -User Input

// ACC-24M2A ECT Setup

//Channel 1

MS0,MI120=$30FF54 // Data Source Address location
MS0,MI121=$000FFF // 12-bit SSI conversion
MS0,MI122=MaxVelChl*32

//Channel 2

MS0,MI123=$30FF74 // Data Source Address location
MS0,MI124=$000FFF // 12-bit SSI conversion
MS0,MI125=MaxVelCh2*32

// ACC-24M2A ECT output setup
MS0,MI101=$12 // Output from 3"® line of ECT (MI122)
MS0,MI102=$15 // Output from 6" line of ECT (MI125)

Example: ACC-24M2A with two motors, each with a 16-bit SSI encoder, one on Node 0, one on
Node 1

#define MaxVelChl 0 // Maximum count change per servo cycle, Channel 1 -User Input
#define MaxVelCh2 0 // Maximum count change per servo cycle, Channel 2 -User Input

// ACC-24M2A ECT Setup

//Channel 1

MS0,MI120=S30FF54 // Data Source Address location
MS0,MI121=$00FFFF // 1l6-bit SSI conversion
MS0,MI122=MaxVelChl*32

//Channel 2

MS0,MI123=$30FF74 // Data Source Address location
MS0,MI124=S$00FFFF // 16-bit SSI conversion
MS0,MI125=MaxVelCh2*32

// ACC-24M2A ECT output setup
MS0,MI101=$12 // Output from 3™® line of ECT (MI122)
MS0,MI102=$15 // Output from 6™ line of ECT (MI125)
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Example: ACC-24M2A with two motors, each with a 20-bit SSI encoder, one on Node 0, one on

Node 1
#define MaxVelChl 0 // Maximum count change per servo cycle, Channel 1 -User Input
#define MaxVelCh2 0 // Maximum count change per servo cycle, Channel 2 -User Input

// ACC-24M2A ECT Setup

//Channel 1

MS0,MI120= $30FF54 // Data Source Address location
MS0,MI121=$0FFFFF // 20-bit SSI conversion
MS0,MI122=MaxVelChl*32

//Channel 2

MS0,MI123= $30FF74 // Data Source Address location
MSO,MI124=S0FFFFF // 20-bit SSI conversion
MS0,MI125=MaxVelCh2*32

// ACC-24M2A ECT output setup
MS0,MI101=512 // Output from 3°¢ line of ECT (MI122)
MS0,MI102=515 // Output from 6 line of ECT (MI125)

Example: ACC-24M2A with two motors, each with a 24-bit SSI encoder, one on Node 0, one on

Node 1
#define MaxVelChl 0 // Maximum count change per servo cycle, Channel 1 -User Input
#define MaxVelCh2 0 // Maximum count change per servo cycle, Channel 2 -User Input

// ACC-24M2A ECT Setup

//Channel 1

MS0,MI120= $30FF54 // Data Source Address location
MSO,MI121=SFFFFFF // 24-bit SSI conversion
MS0,MI122=MaxVelChl*32

//Channel 2

MS0,MI123= S$S30FF74 // Data Source Address location
MS0,MI124=$FFFFFF // 24-bit SSI conversion
MS0,MI125=MaxVelCh2*32

// ACC-24M2A ECT output setup
MS0,MI101=$12 // Output from 3"® line of ECT (MI122)
MS0,MI102=$15 // Output from 6" line of ECT (MI125)

user must save the setting, MSSAVE{node} and reset the card

If the direction decode variable, MS<node>, MI1910, is changed the
Ai@

MS$$${node} before the fractional direction sense matches.

At this point of the setup process, you should be able to move the
= motor/encoder shaft by hand and see encoder counts in the position

window
Note
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Resolver

ECT Setup

ACC-24M2A has up to two channels of resolver inputs. The inputs may be used as feedback or master
reference signals for the PMAC servo loops. The basic configuration of the drive contains one 10-bit fixed
resolution tracking resolver-to-digital (R-to-D) converters, with an optional second resolver when a dual
axis driver is ordered. ACC-24M2A creates the AC excitation signal (ResOut) for up to two resolvers,
accepts the modulated sine and cosine signals back from these resolvers, demodulates the signals and
derives the position of the resolver from the resulting information, in an absolute sense if necessary.

The specifics for this configuration are as follows (Chl and Ch2):

Example: ACC-24M2A with two motors, each with a resolver, one on Node 0, one on Node 1,
wherein the clockwise direction of the motor’s shaft’s rotation is positive

// ACC-24M2A ECT Setup

// Channel 1

MS0,MI120=$EOFF00 // Data Source Address location ,CW
MS0,MI121=$00FF5C // A/D Converter Address Setup
MS0,MI122=0 // Sine/Cosine Bias -User Input

// Channel 2 CW

MS0,MI123=SEO0FF20 // Data Source Address location, CW
MS0,MI124=$00FF5C // A/D Converter Address Setup
MS0,MI125=0 // Sine/Cosine Bias -User Input

// ACC-24M2A ECT Output Setup
MS0,MI101=$12 // Output from 3 line of ECT (MI122)
MS0,MI102=$15 // Output from 6® line of ECT (MI125)

Example: ACC-24M2A with two motors, each with a resolver, one on Node 0, one on Node 1,
wherein the counterclockwise direction of the motor’s shaft’s rotation is positive

// ACC-24M2A ECT Setup

// Channel 1

MS0,MI120=$E8FF00 // Data Source Address location ,CCW
MS0,MI121=$S00FF5C // A/D Converter Address Setup
MS0,MI122=0 // Sine/Cosine Bias -User Input

// Channel 2 CW

MS0,MI123=$E8FF20 // Data Source Address location, CCW
MS0,MI124=$00FF5C // A/D Converter Address Setup
MS0,MI125=0 // Sine/Cosine Bias -User Input

// ACC-24M2A ECT Output Setup
MS0,MI101=$12 // Output from 3"® line of ECT (MI122)
MS0,MI102=$15 // Output from 6" line of ECT (MI125)

Note that the third line of the entry for each channel (in this example, M1122 for Channel 1 and M1124 for
Channel 2) contains the bias in the A/D converter values. This line should contain the value that the A/D
converters report when they should ideally report zero. The MACRO Station subtracts this value from
both A/D readings before calculating the arctangent. Many users will leave this value at 0, but it is
particularly useful to remove the offsets of single-ended analog encoder signals. If it appears that the
encoder has an offset, the user can compensate for it in these variables. This line is scaled so that the
maximum A/D converter reading provides the full value of the 24-bit register (+/-2%). Generally, it is set
by reading the A/D converter values directly as 24-bit values (in this example, from Y:$C090 for Channel
1 and from Y:$C098 for Channel 2), computing the average value over a cycle or cycles, and entering this
value here.
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user must save the setting, MSSAVE{node} and reset the card

If the direction decode variable, MS<node>, MI1910, is changed the
MS$$${node} before the fractional direction sense matches.

Note

Configuring Excitation Frequency

After setting up the ECT, the user then must set three MI-Variables for the Resolvers to function
correctly.

The ResOut signal (i.e. the Resolver’s excitation frequency) emitted from the ACC-24M2A is derived
from the Phase Clock frequency of the MACRO set by M1992 and MI1997. The user has the ability to
select the excitation frequency to be equal with the Phase Clock frequency (default) by setting
MS<node>,M1982 equal to 0. Or, the user can use lower frequencies by increasing the value of M1982.

M1982 affects the excitation frequency as follows:

M1982 Setting Excitation Frequency
M1982=1 (Phase Clock Frequency)/2
M1982=2 (Phase Clock Frequency)/4
M1982=3 (Phase Clock Frequency)/6
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Configuring the Excitation Signal’s Gain
Additionally, the user needs to set the Excitation output gain for the system’s resolvers by setting
MS<node>,M1981.

MI981 affects the excitation signal’s gain as follows:

M1981 Setting Excitation Signal Gain
M1981=0 2.5V
MI1981=1 5.0 Vpp
MI1981=2 7.5V
M1981=3 10.0 Vyp

Configuring the Excitation Signal’s Phase Offset

Finally the resolver excitation phase time offset, MS<node>, M1980, needs to be set. The optimum
setting of M1980 depends on the L/R time constant of the resolver circuit. Therefore, MI1980 should be set
interactively to maximize the magnitudes of the feedback ADC values.

For each channel, there are two ADC registers which hold the sin and cosine values. For Channel 1, the
base/first ADC register address is Y:$FF0O0 and the second ADC register address is Y:$FF01; For
Channel 2, the base/first ADC register address is Y:$FF20 and the second ADC register address is
Y:$FF21. There is no MI-Variable to directly address these registers, so M1198 (Direct Read/Write Format
and Address) and MI1199 (Direct Read/Write Variable) will be used here. For each channel, both ADCs
should be observed during setup. Notice that M1199 can only be pointed to one register at one time so it
must be configured twice throughout the following procedure.

Procedure for Configuring M1980 on Channel 1
The procedure for configuring MI1980 for Channel 1 is as follows:

1. InPeWin32Pro2, open a Watch Window (View->Watch Window).

2. Press “Insert” and type MS<node>,M1199, where <node> is the node number of this ACC-
24M2A’s motor (e.g. if this motor is on Node 0, type MS0,M1199).

3. Inthe Terminal Window (View->Terminal), type MS<node>,M1198=$6DFF00, where <node>
is this motor’s node (as in step 2). This points MI199 to the Channel 1’s ADCI.

4. Rotate the motor on this channel. Observe MS<node>,MI1199 in the Watch Window. If it
saturates to £32767, the resolver gain (M1981) is too high. Decrease MI1981 until the MI1199 just
barely saturates to £32767. If it does not saturate, type MS<node>,M1198=$6DFFO1 in the
Terminal Window (which sets MI199 to point to Channel 1’s ADC2) and then repeat step 4.

5. Set MI199 to point to the ADC which saturated; that is, if ADC1 saturated, type
MS<node>,M1198=$6DFFQ0 in the Terminal Window, or if ADC2 saturated, type
MS<node>,MI1198=$6DFFO01 in the Terminal Window.

6. Position the motor’s shaft such that the ADC value is close to the maximum value observed
throughout one revolution of the motor’s shaft. At this point, the other ADC should be close to 0.

7. Increase M1980 by increments of 25. The ADC value should start to increase slowly. If it
decreases, instead start with M1980=255 and then decrease M1980 by increments of 25. The ADC
value should increase up to a maximum point and then start to decrease again. Set M1980 to the
value that produced the largest absolute ADC value achieved throughout the process of adjusting
M1980.

8. If the maximum absolute value of this ADC is less than 16,000, increase the gain of the resolver
by increasing MI1981.
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Procedure for Configuring M1980 on Channel 2
The procedure for configuring MI1980 for Channel 2 is as follows:

1.
2.

3.

In PeWin32Pro2, open a Watch Window (View->Watch Window).

Press “Insert” and type MS<node>,M1199, where <node> is the node number of this ACC-
24M2A’s motor (e.g. if this motor is on Node 0, type MS0,M1199).

In the Terminal Window (View-> Terminal), type MS<node>,M1198=$6DFF20, where <node>
is this motor’s node (as in step 2). This points MI1199 to the Channel 1’s ADCI.

Rotate the motor on this channel. Observe MS<node>,MI1199 in the Watch Window. If it
saturates to £32767, the resolver gain (M1981) is too high. Decrease MI1981 until the MI1199 just
barely saturates to +32767. If it does not saturate, type MS<node>,M1198=$6DFF21 in the
Terminal Window (which sets MI199 to point to Channel 1’s ADC2) and then repeat step 4.

Set MI199 to point to the ADC which saturated; that is, if ADC1 saturated, type
MS<node>,MI1198=$6DFF20 in the Terminal Window, or if ADC2 saturated, type
MS<node>,MI1198=$6DFF21 in the Terminal Window.

Position the motor’s shaft such that the ADC value is close to the maximum value observed
throughout one revolution of the motor’s shaft. At this point, the other ADC should be close to 0.
Increase M1980 by increments of 25. The ADC value should start to increase slowly. If it
decreases, instead start with M1980=255 and then decrease M1980 by increments of 25. The ADC
value should increase up to a maximum point and then start to decrease again. Set M1980 to the
value that produced the largest absolute ADC value achieved throughout the process of adjusting
M1980.

If the maximum absolute value of this ADC is less than 16,000, increase the gain of the resolver
by increasing M1981.

At this point of the setup process, you should be able to move the
= motor/encoder shaft by hand and see encoder counts in the position

window

Note
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Flags
On the Ring Controller, the flags (Ixx25) must point to the servo node’s flag addresses used for the
motors on ACC-24M2A.

Example: Motors 1-2 on Nodes 0 and 1, respectively

1125=$3440
1225=53441

other motors, refer to the Turbo PMAC Software Reference Manual
under the entry for [xx25, under the “Turbo PMAC?2 Ultralite” table
Note for a list of the addresses for I1xx25.

These examples configure only motors 1-2. If you are configuring

Then, on the Ring Controller, the flag control (Ixx24) variable must be set up for each motor on ACC-
24M2A as follows:

Ixx24 Setting Description
$40001 Overtravel limits enabled
$60001 Overtravel limits disabled

Example: Flag Control for Motors 1-2

1124,2,100=$40001 // Motor 1-2 have overtravel limits enabled

Output Commands
On the Ring Controller, the output command address must be set to the ACC-24M2A’s motors’ servo
node addresses directly.

Example: Motors 1-2 on Nodes 0 and 1, respectively

I102=$078420 // Motor 1l’s output command address is Node 0
I1202=$078424 // Motor 2’'s output command address is Node 1

other motors, refer to the Turbo PMAC Software Reference Manual
under the entry for Ixx02, under the under “Turbo PMAC?2 Ultralite”
Note table for a list of the addresses for Ixx02.

These examples configure only motors 1-2. If you are configuring
A@'
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2T Settings

The I2T overcurrent protection should be configured for each motor on ACC-24M2A. Below is an
example with some formulas for setting up 12T; the user simply needs to fill in the values specified by “-
User Input” in the comments on that line:

Example: Configuring 12T Protection for Motors 1-2

I15=0 ; Trigonometric calculation in degrees
#define MaxPhaseFreq P7000 ; Max Phase Clock [KHz]

#define PWMClk P7001 ; PWM Clock [KHz]

#define PhaseClk P7002 ; Phase Clock [KHz]

#define ServoClk P7003 ; Servo Clock [KHz]

MaxPhaseFreq=117964.8/(2*16800+3)
PWMC1k=117964.8/ (4*16800+6)
PhaseClk=MaxPhaseFreq/ (16801+1)
ServoClk=PhaseClk/ (I16802+1)

#define AxislMinContCurrent 3 ; Continuous Current Limit for Axis 1 [Amps] -User Input
#define AxislMinPeakCurrent 9 ; Instantaneous Current Limit for Axis 1 [Amps] -User Input
#define AxislAmpPeakInstCurrent 16.3 ; Peak Instant. Current of Amplifier [Amps] -User Input
#define AxislI2TOnTime 2 ; Time allowed at peak Current [sec]

// Assuming that motor 1 is the first motor on MACRO

I157=INT (32767* (AxislMinContCurrent/AxislAmpPeakInstCurrent)

I169=INT (32767* (AxislMinPeakCurrent/AxislAmpPeakInstCurrent)
T158=INT((I169*T1169-1157*1157) *ServoClk*1000*Ax1is1I2TOnTime/ (32767*32767))
I257=1157 1269=I1169 1258=I158 // Assumes motor 2 is the same as motor 1

The continuous current limit (Axis1LMinContCurrent) and the instantaneous current limit
(Axis1MinPeakCurrent) values on the lines with “-User Input” in the comment above should be the
smaller of the two limits between your motor and your amplifier’s specifications.
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DAC Calibration

Before performing the DAC Calibration, make sure there is no

load attached to the motor, and make sure that the motor can

safely and freely move. This step of the setup can generate much
WARNING motion in the motor.

At this stage in the setup, the user should calibrate the DACs on ACC-24M2A to make sure that when he
or she commands 0 volts on the DACs, they actually put out 0 volts. To do this, open PMAC Tuning Pro2
by clicking on Tools>PMAC Tuning Pro2 from within PeWin32Pro2. Then, click Position Loop—>DAC
Calibration. Make sure there is no load presently connected to the motor. Then, click “Begin Calibration.”
PMAC will automatically calibrate your DAC. Once it is done, accept the change it makes to 1xx29. You
may want to write down this value to add to your setup file. Do this test for both motors (you can select
another motor with the Motor Select button):

L]

File CurrentLocp Position Loop  Trajectory  Tools Window Help

Mumber of test lterationg:

Calibration ztep size:

Begin Calibration | Done | Enable Motar #1 |
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Open Loop Test

Before performing the Open Loop Test, make sure there is no
load attached to the motor, and make sure that the motor can
safely and freely move. This step of the setup can generate much

WARNING motion in the motor.

The user should now execute an Open-Loop test in order to determine whether the feedback from ACC-

24M2A is working properly. To do this, open PMAC Tuning Pro2 from PeWin32Pro2 by clicking on

Tools>PMAC Tuning Pro2. Then, click Position Loop—>Open Loop Test.

EIPmacTuningPro2 v4.0.0 PMAC:0 V1.947T2 05/17/2010 QMAC TURBO: USB Port

File Currentloop | Positionloop Trajectory Tools Window Help

e AR-E

Exterd Servo Algoritn
Filters
Garnry PID

ElOpen Loop Test :

CIPMAC:0 V1.94712 05171... |- [0 X)

Pmac Terminal Ready...
MS0.1910-3

6/2/2010 10:32:30 # #9 81 % 100 Previous Command it/

Kl PmacTuningPro2 Open Loop Test Result: Motor #9
J ‘Ha k- RREER|Q&F | LB &[>

EEX

Motor #9 Open Loop Test Plot Result : Executed at 10:32:17 AM 6/2/12010

100000
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il

-250.00-

-500.00-

2
£
g
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750,00

100000

120 e0 200 240 280 320
Time: (msec)

“ou should see an incressing velocty curve during the postive

‘segment of the currert command, snd & decreasing velacty curve

curing the negative segment of the current command
“OUR ENCODER IS DECODING CORRECTLY!

59400.00

49500.00

39600.00

20700.00

19800.00

ss00.00

000

-ga00.00

-19800.00

28700.00

(2asysi2) Ao

— Commanded Yotage

— Welocity

You should see the actual velocity increasing positively while the commanded velocity is positive, the

actual velocity decreasing while the commanded velocity is negative.

If you see an erratic response, or an inverted saw tooth, then most likely the encoder decode setting is
incorrect. This is on the MACRO side, MS{node},M1910 has to be changed from 7 to 3, or vice versa.
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Servo Loop Tuning

PMAC’s Servo Algorithm must be configured to properly control any given system with motors and
amplifiers. Configuration is done by adjusting I-Variables (Ixx30 through Ixx35) pertaining to the PID
gains. Ixx68 (Friction Feedforward) is also needed. The servo loop gains correspond to I-Variables as
follows:

Ixx30 Proportional Gain (Kp)

Ixx31 Derivative Gain (Kq)

Ixx32 Velocity Feedforward (K)
Ixx33 Integral Gain (K;)

Ixx34 Integration Mode

Ixx35 Acceleration Feedforward (Kg)
Ixx68 Friction Feedforward (Ks)

A The user should connect the load to the motor before tuning the servo
(=2 loop.

Note

YVVVYVVYYVY

The process of determining proper values of PID gains is called “Tuning.” The procedure for tuning is as
follows:

1. Set Ixx34 (Motor xx PID Integration Mode) — can be changed on the fly as needed
=1, position error integration is performed only when Motor xx is hot commanding a move
=0, position error integration is performed always

2. Using the Step Response, tune the following parameters in this order:
Proportional Gain, Kp (Ixx30)
Derivative Gain, Kd (Ixx31)
Integral Gain, Ki (Ixx33)

3. Using the Parabolic Move, tune the following parameters in this order:
Velocity Feedforward, Kvff (Ixx32)
Acceleration Feedforward, Kaff (1xx35)
Friction Feedforward, Kfff (Ixx68)

¢ When tuning the feedforward gains, set Ixx34=1 so that the

dynamic behavior of the system may be observed without
A integrator action. After tuning these, set 1xx34 back to your
(=2 desired setting.
Note e Setting Kvff = Kd (Ixx32 = Ixx31) is a good place to start

when tuning Kvff,
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Steps 2 and 3 should be performed in the Interactive Tuning window in PMAC Tuning Pro2:

k& PmacTuningPro2 v4.0.0 PMAC:0 V1.945 07/02/2008 UMAC TURBO: USB Port

File CurrentLoop Position Loop Trajectory Tools Window Help

v % e 5]
m e '@ o @ @ [ ] o “‘_ w o E
AUTO THTER | AUTO INTER | ‘Semee o) "= o
Elrip Interactive Tuning Motor #1 |Z||§|E\
Present PID Terms Step Move
Interactive Tunin A S
g Il (k) [i280 : Step Time (maj - 500
ti 1xx32 [Kvff])  [15050 PID Diagram
fo r PO S I t I 0 n B ,7 Traectony Selection
et (K3 5000 + Position Step
1
34 (1M ) " Position Ramp Do A Step Move
0
1x35 [ Kaff ) " ParabolicVelocity
1xx29 0 ® TicpeasiVelsiy ™ Kill Motor After Step Move
14469 20480 r 5-Curva Velociy [~ Move in one direction
(EESEHD o " Sinusnidal
lu68 0 " Sine Sweep Left Axis Plot
bt 32000 " User Defined [Posiin =l
Right Auis Plat
Enable Motor #1 Hotch Filt Low Pass Filt
nal -B otor | _EDC ter _I]E! ass Filter |NDHE j
Ezit
IL = | MNotch/Low Pass Filter Setup |
8 | B Motch/Low Pass Filter Inactive

Step 2 (tuning K, Kg, and Kj)

Select “Position Step” under “Trajectory Selection.” Choose a “Step Size” (under “Step Move”) that is
within ¥ to ¥ of a revolution of the motor if it is a rotary motor, or within %2 to ¥4 of one electrical cycle if
it is a linear motor. The step move’s commanded position profile should look somewhat like this:

Commanded
Position [cts]

Time [sec]

Now, compare your motor’s actual position to the commanded position profile. Depending how the actual
position looks, adjust the servo loop gains until you achieve the desired response.
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Observing the table below, match your actual position response to one of the response shapes below, and

then adjust the appropriate gain as listed next to each plot:

Overshoot and
Oscillation
Cause:

Position Offset
Cause:

Too much Proportional
gain or
too little Damping
Fix:
Decrease K, (Ixx30)

Friction or Constant
Force
Fix:
Increase K; (Ixx33)
Increase K, (Ixx30)

Increase Ky (Ixx31)

Sluggish Response
Cause:
Too much Damping or
too little Proportional

Physical System
Limitation
Cause:

Limit of the
Motor/Amplifier/Load

gain and gain combination

Fix: Fix:
Increase K, (Ixx30) or Evaluate Performance
Decrease Ky (Ixx31) and

maybe add K, (Ixx30)

Typically, one should start by increasing K, until one observes the “Overshoot and Oscillation” condition
(upper left corner’s plot), and then increase K4 and K; until the performance goals for the step response
are achieved. Be sure when executing the step response that you plot the Servo Command on the Right

E=R(EcR 5
Step Move
Step Size [cls): 1000
500

Step Time [msg] :

Do A Step Move ‘

[~ Kill Motor After Step Move

[~ Move in one direction

Left Axiz Plat

|F'Dsitiu:|n j
Right &siz Plot

Servo Command -

AXis:
2@ PID Intera ctiveTuning Motor #1
Present PID Terms
Ixx30 [ Kp ) 2500
Ixx31 [Kd ] 40
1xx32 [ Kwif ] 320 PID Diagram
L33 [ Ki 000 Trajectory Selection
FARLE + Position Step
Ixx34 [ 1M 1 iy
1 " Pasition Ramp
lxx35 [ Kaff 2300 ) ]
w35 [ Kaff ) " Parabolicvelocity
0 : :
= " Trapezoidal Welocity
20480 .
lx63 " 3-Curse Welocity
[F=ED 0  Sinusoidal
lxx68 0 " Sine Sweep
lzx11 32000 " Usger Defined
Motch Filter Low Pass Filter
= Calculator Calculator
1 Ezit | =
Motch/Low Pass Filter Setup ‘
&3 2 Motch/Low Pass Filter Inactive
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If you see a truncation of the servo command at the beginning of each move, you have reached the
maximum output command as determined by Ixx69. In this case, adding more K, will not improve the

Step Response’s performance.

Step 3 (Tuning Ky, Karr, and Kyer)

Select “Parabolic Velocity” under the “Trajectory Selection” in the Interactive Tuning Window. Select a
move size and speed that will simulate the fastest, harshest moving conditions you expect your machine
to experience. Tune the motor at these settings, and then the motor should be able to handle all easier

MOoVes.

After commanding the Parabolic Velocity move, the commanded Velocity Profile and Acceleration

Profile should look like this:

Velocity
Commanded

Profile ‘ \/

Acceleration
Commanded
Profile

Observing the table below, match your following error response to one of the response shapes below, and

then adjust the appropriate gain as listed next to each plot:

High Vel ./F.E.

Fix: Increase Ky
(Ixx32)

Correlation V\
Cause: Damping

High Acc./F.E.
Correlation
Cause: Inertial Lag
Fix:
Increase Kg (Ixx35)

High Vel./F.E.
Correlation
Cause: Friction
Fix:

Add Friction
Feedforward (Ixx68)
and/or turn on Integral
Gain
(Ixx33, Ixx34)
High Acc./F.E.
Correlation
Cause:
Physical System
Limitation
Fix:

Use softer acceleration
or add more Ixx68
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Negative Vel./F.E.
Correlation
Cause:

Too much Velocity
Feedforward

Fix:

Decrease Ky
(Ixx32)

Negative Acc./F.E.
Correlation
Cause:

Too much acceleration

Feedforward
Fix:

Decrease Ky (1xx35)

M\

N/

High Vel ./F.E.
Correlation

Cause: Damping &
Friction

Fix:

Increase K first
(Ixx32)

Possibly adjust
Ixx68

High Vel./F.E. &
Acc./F.E.
Correlation

Cause:

Inertial Lag &
Friction

Fix:

Increase Ky (IXx35)
Possibly adjust 1xx68
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CONFIGURING WITH POWER PMAC

Quick Review: Nodes and Addressing

Two different types of MACRO interfaces are available for Power PMAC: Gate2-style and Gate3-style.

Gate3-style MACRO interfaces have two “banks” of MACRO registers, “Bank A” and “Bank B.” As of
the date this manual was written, ACC-5E3 is the only Gate3-style MACRO interface for Power PMAC.

Gate2-style MACRO interfaces have up to two ICs, each possessing its own registers for MACRO
settings. As of the date this manual was written, ACC-5E is the only Gate2-style MACRO interface for
Power PMAC.

Each MACRO IC (for Gate2-style MACRO interfaces) or each MACRO bank (Bank A and Bank B, for
Gate3-style MACRO interfaces) consists of 16 nodes: 2 auxiliary, 8 servo, and 6 1/0 nodes:

e Auxiliary nodes are Master/Control registers and are for internal firmware use.

e Servo nodes carry information such as feedback, commands, and flags for motor
control.

e |/O nodes are by default unoccupied and are user configurable for transferring
miscellaneous data.

Each motor that the ring controller controls requires one servo node, and therefore one ACC-5E3 or
ACC-5E can control a maximum of 16 motors. The number of 1/0 nodes used depends on what I/O
devices ACC-5E3 or ACC-5E is controlling over the MACRO ring. A visual representation of the nodes’
individual functionality is given below:

I/O Nodes

Node | 15|14 |13 |12 |11|(10| 9 | 8 [ 7 [ 6 | 5 | 4 |3 | 2 |1 | O
.
Auxiliary
Nodes Servo Nodes

With Gate3-style MACRO, each node consists of 8 registers: four 32-bit “Input” registers, which can be
accessed by the structure Gate3[i].MacrolnA[j][K] for bank A and Gate3[i].MacrolnBJj][k] for bank B,
and four 32-bit “Output” registers, which can be accessed by the Power PMAC structures
Gate3[i].MacroOutA[j][k] for bank A and Gate3[i].MacroOutB[j][k] for bank B. Gate2-style MACRO
interfaces has 4 registers for each node, wherein the input and output data share the registers; they are all
grouped into this structure: Gate2[i].Macro[j][k].
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Data Organization within Servo Nodes

When controlling non-Gate3 MACRO Stations, each MACRO interface will have its servo node
information split up differently within each node j depending on the commutation method being used.
The three modes involved are:

Analog Output Mode
Motor[x].PhaseCtrl = 0
Motor[x].pAdc =0

UV Commutation Mode (a.k.a. Sinusoidal Commutation Mode)
Motor[x].PhaseCtrl > 0
Motor[x].pAdc =0

Direct PWM Mode

Motor[x].PhaseCtrl > 0

Motor[x].pAdc >0 (=Gate3[i].MacrolnA[j][1] for MACRO motors on Gate3-style MACRO,
=Gate2[i].Macrolj][1] for Gate2-style)

In Gate3-style MACRO, the contents of each servo node are arranged in each MACRO bank as follows:

Gate3-Style MACRO Bank A Register Structure

Node Structure Bit 31 Bit O

Gate3[i].MacrolnAl[j][0] 24 bits of feedback information 8 bits of 0

Not Used in Analog Output Mode/
Gate3[i].MacrolnA[j][1] Not Used in UV Commutation Mode/ 16 bits of O
16 bits of current sensor ADCA in Direct PWM Mode

Not Used in Analog Output Mode/
Gate3[i].MacrolnA[j][2] Not Used in UV Commutation Mode/ 16 bits of 0
16 bits of current sensor ADCB in Direct PWM Mode

Gate3[i].MacrolnA[j][3] 16 bits of channel status/flag information 16 bits of 0

24 bits of servo output command in Analog Output Mode/

24 bits of PWMA command in Direct PWM Mode

Gate3[i].MacroOutA[j][0] 24 bits of DACA output in UV Commutation Mode/ 8 bits of 0

Not Used in Analog Output Mode/
Gate3[i].MacroOutA[j][1] 16 bits of DACB command in UV Commutation Mode/ 16 bits of O
16 bits of PWMB command in Direct PWM Mode

Not Used in Analog Output Mode/
Gate3[i].MacroOutA[j][2] Not Used in UV Commutation Mode/ 16 bits of O
16 bits of PWMC command in Direct PIWM Mode

Gate3[i].MacroOutA[j][3] 16 bits of channel control commands/flag commands 16 bits of O
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Gate3-Style MACRO Bank B Register Structure

Node Structure

Gate3[i].MacrolnB[j][0] 8 bits of 0

Gate3[i].MacrolnB[j][1] 16 bits of 0

Gate3[i].MacrolnB[j][2] 16 bits of 0

Gate3[i].MacrolnB[j][3] 16 bits of 0

Gate3[i].MacroOutBJ[j][0] 8 bits of 0

Gate3[i].MacroOutBJj][1] 16 bits of 0

Gate3[i].MacroOutBlj][2] 16 bits of 0

Gate3[i].MacroOutBJ[j][3] 16 bits of 0
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In Gate2-style MACRO, the contents of each servo node are arranged in each MACRO IC as follows:

Gate2-Style MACRO Input Register Structure
Node Structure Bit 23 Bit 0
Gate2[i].Macro[j][0] 24 bits of feedback information
Not Used in Analog Output Mode/
Gate2[i].Macro[j][1] Not Used in UV Commutation Mode/ 8 bits of 0
16 bits of current sensor ADCA in Direct PWM Mode
Not Used in Analog Output Mode/
Gate2[i].Macro[j][2] Not Used in UV Commutation Mode/ 8 bits of 0
16 bits of current sensor ADCB in Direct PIWM Mode
Gate2[i].Macro[j][3] 16 bits of channel status/flag information 8 bits of 0
Gate2-Style MACRO Output Register Structure
Node Structure Bit 23 Bit 0
24 bits of servo output command in Analog Output Mode/
Gate2[i].Macro[j][0] 24 bits of DACA output in UV Commutation Mode/
24 bits of PWMA command in Direct PWM Mode
Not Used in Analog Output Mode/
Gate2[i].Macro[j][1] 16 bits of DACB command in UV Commutation Mode/ 8 bits of 0
16 bits of PWMB command in Direct PIWM Mode
Not Used in Analog Output Mode/
Gate2[i].Macro[j][2] Not Used in UV Commutation Mode/ 8 bits of 0
16 bits of PWMC command in Direct PWM Mode
Gate2[i].Macro[j][3] 16 bits of channel control commands/flag commands 8 bits of 0
Since no Gate3-style MACRO Station products have yet been developed, this is the only node
arrangement available until future developments.
1/0 Nodes can be arranged in any way desired, and as such, this
= manual does not have any section describing any specific data
arrangement structure within 1/O nodes.
Note
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Setup Overview

This setup assumes that:

The Ring Master has already been properly configured to run its own local motors.
The user is familiar with enabling servo nodes on both the MACRO Ring Controller and Slave
Station.

In order to set up ACC-24M2A with Power PMAC, the user must:

1.

Nookw

On the Ring Master, enable one (if ACC-24M2A will only use one motor) to two (using two
motors) servo nodes (any two unused servo nodes) per ACC-24M2A.

Structures involved for Gate3-Style MACRO Interfaces:
Gate3[i].MacroEnableA — MACRO IC Bank A Node Activate Control
Gate3[i].MacroEnableB — MACRO IC Bank A Node Activate Control

Gate3[i].MacroModeA — MACRO IC Bank A Status and Control
Gate3[i]. MacroModeB — MACRO IC Bank B Status and Control

Structures involved for Gate2-Style MACRO Interfaces:
Gate2[i].MacroEnable — MACRO IC Node Activate Control
Gate2[i].MacroMode — MACRO IC Ring Configuration/Status

Also, make sure Macro.TestPeriod, Macro.TestMaxErrors, and Macro. TestReqdSynchs
have been properly configured on the Master.

Establish communication between the Master and the ACC-24M2A using MACRO ASCII Mode
and enable one or two servo nodes on ACC-24M2A corresponding to the nodes activated on the
Master.

Variables involved:

MacroSlave{anynode},MI11 MACRO Station Station Number
MacroSlave{anynode},M1995 MACRO Ring Configuration/Status
MacroSlave{anynode},M1996 MACRO Node Activate Control

Set up Feedback.

Set up Flag and Output Command Registers.
Configure 12T Protection.

Perform an Open Loop Test.

Tune the Servo Loop.
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Setup Step 1. MACRO Connectivity

ACC-24M2A requires that the same number of servo nodes be activated on the Power PMAC as there are
motors being used on ACC-24M2A,; e.g. two servo nodes should be enabled on the Ring Controller if
using two motors, one servo node if using only one motor. Power PMAC MACRO has three variables for
error checking that must also be configured:

Macro.TestPeriod
This is the period in milliseconds at which PMAC checks for errors on the MACRO ring. The
recommended value for this variable is 20.

Macro.TestMaxErrors
This is the maximum error count PMAC can receive in one test period (whose duration is specified by
Macro.TestPeriod) before triggering a fault. The formula for computing this variable is as follows:

Macro.TestMaxErrors=Macro.TestPeriod/10.
Macro.TestReqdSynchs

This is the number of sync packets in one period (whose duration is specified by Macro.TestPeriod) that
PMAC must receive before triggering an error. The formula for computing this variable is as follows:

Macro.TestReqdSynchs=Macro.TestPeriod-Macro.TestMaxErrors.
Example MACRO Communication Setup

Configuring a Gate3-Style MACRO interface to enable 16 servo nodes and 12 1/0O nodes on a Power
PMAC, which is acting as a Ring Controller.

Sys.WpKey=SAAAAAAAA;

// MACRO Communication Setup

Gate3[0] .MacroEnableA=S0FFFFF00; // Activate 8 Servo Nodes and 6 I/0 Nodes of MACRO A
Gate3[0] .MacroModeA=$403000; // Set MACRO A as master

Gate3[0] .MacroEnableB=S1FFFFF00; // Activate 8 Servo Nodes and 6 I/0 Nodes of MACRO B
Gate3[0] .MacroModeB=5$9000; // Set MACRO B as master to synchronize clock
Macro.TestPeriod=20; // MACRO Ring Check Period [msec]
Macro.TestMaxErrors=Macro.TestPeriod/10; // MACRO Maximum Ring Error Count

Macro.TestRegdSynchs=Macro.TestPeriod - Macro.TestMaxErrors; // MACRO Minimum Sync Packet Count
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Setup Step 2: Communicating with ACC-24M2A over MACRO ASCII

ACC-24M2A has no rotary switches to determine its MACRO Station Number. Therefore, ACC-24M2A
uses the Ring Order method to obtain its Station Number. Before the ACC-24M2A has been initialized, it
will by default be at MACRO Station #255.

If ACC-24M2A is not at factory default, the user can reinitialize it as follows:

e If using MACRO IC #0, to reinitialize ACC-24M2A, type MacroSlave$$$***15, then
MacroSlaveSAVE15, then MacroSlave$$$15.

e Ifusing MACRO IC #1, type MacroSlave$$$***31, then MacroSlaveSAVE31, then
MacroSlave$$$31.

e Ifusing MACRO IC #2, use MacroSlave$$$***47, then MacroSlaveSAVA47, then
MacroSlave$$$47, and so on for other MACRO IC #s.

Then, establishing communication is as follows:

1. Within the Power PMAC IDE, in the Terminal Window, type MacroStation255.
2. Type I11=nin order to assign this ACC-24M2A to Station #n.

A ACC-24M2A must be assigned to any unused Station Number (e.g.
L= 111=1 to assign ACC-24M2A to Station #1).

Note

If a Macro 1/O error is received, make sure the Ring Controller’s MACRO communication settings
are set correctly. Also make sure that the ACC-24M2A has not been assigned a Station number
already. If the Station has already been assigned a Station number, there are two options:

A. Find out the station number n and enter MacroStation<n> (without the angular
brackets), where n is the station number, to initiate MACRO ASCII communication with
the Station.

C. Reset the station number of all the Stations by entering MacroStation0 and then enter
111=0.

w

Type <MacroStationClose to exit MACRO ASCII Mode.

4. Type MacroStation<n> (without the angular brackets), where n is the Station Number assigned
in step 2 (e.g. MacroStationl to open ASCII communication with Station #1).

5. Assign the node and master number on the ACC-24M2A with MI1996.

For example, to assign the Station to Nodes 0 and 1 on Master IC #0 on the ACC-24M2A, type:

| MI996=$FC003 |

6. Set M1995=$80.

Example:
| MI995=580

7. Type <MacroStationClose to exit MACRO ASCII Mode.
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Setup Step 3: Motor Setup

Clocks

For simplicity, set the max phase and clock dividers the same as the ring controller, but note that the servo

rate on the Geo MACRO Drive is independent and can be set to a different frequency. The variables to
use on the MACRO Station for setting clocks are as follows:

MacroSlave{anynode},1992 // Max Phase Clock
MacroSlave{anynode},1997 // Phase Clock Divider
MacroSlave{anynode},1998 // Servo Clock Divider

The formulas for determining what value to which to set these variables are as follows:

MI992 = (%) —1,

fmp

MI997 = (@”—p) —1,

p
and

MI998 = (’;—") _1,

where fy, is the desired maximum phase frequency [kHz], f, is the desired phase clock frequency [kHz],
and fs is the desired servo clock frequency [kHz].

A The Phase clock on the MACRO Station must be the same as the Ring
B Controller’s, but the Servo Clock can be different.

Note

Example: When Nodes 0 and 1 are being used for ACC-24M2A, setting default clocks

MacroSlave0,MI992=6527
MacroSlave0,MI997=0
MacroSlave(0,MI998=3

Then, issue MacroSlaveSAVE15 followed by MacroSlave$$$15 to save the changes on the Station.
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If you are not sure what your Power PMAC’s clocks are, you can check them by (from within the IDE)
clicking on Tools-> TaskManager, and then clicking on the “Tasks” tab:

P

o' TaskManager : Online[192.168.0.200:55H] =x EoR

CPU Information | Tasks | PLCs I Programs I SubPrograms | Servo | Phase I 05 Hesuurces|

Tasks Cwverview

Tasks Frequency  Calculation Time Peak Time “Task Time
Phase Intemupt 2112 usec
Servo Intermupt 2545kHz 15670 usec 26366 usec 46217%
Real Time Intemupt 2945 kHz 20379 usec BRHE56 usec 6010%
Background Tasks 0986kHz 8790 usec 65535 usec 0867
Buffer Cverview
Buffer Memony Used
Detail=
* Mo motor commutation enabled. -

* Mo maotor digital cument loop active.
* A/D-converter demultiplesdng algorthm MOT enabled.
* Phase divider active.

The Frequency column displays the clock frequencies in kHz for the different clocks in PMAC.

Phase Interrupt is the Phase Clock
Servo Interrupt is the Servo Clock
Real Time Interrupt is the Real Time Interrupt Clock

After observing these clock frequencies, just use the formulas given on the previous page in order to
calculate how to set the clocks on your ACC-24M2A the same as the clocks on your Power PMAC.
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Activating Motors and Disabling Commutation
The user must activate the motor he or she wants to use, and then disable commutation for those motors,
because the ACC-24M2A runs only non-PMAC-commutated motors. On the Ring Controller, the
variable Sys.GatelAutoDetect reports which Gatel-Style Servo ICs are present (such as from ACC-
24E2, ACC-24E2A, or ACC-24E2S) in a Power UMAC rack. Sys.Gate3AutoDetect detects which
Gate3-Style Servo ICs are present in a Power UMAC rack (such as from ACC-24E3). Knowing that each
Servo IC services 4 axes, querying Sys.GatelAutoDetect or Sys.Gate3AutoDetect will reveal how
many local channels are occupied and thus the number of the 1% available motor on a Macro Ring. The
corresponding Motor|[x].ServoCtrl (for activating the motor) and Motor[x].PhaseCtrl (for commutation

settings) settings are given in the rightmost columns:

First
AutoDetect Servo ICs Local | Motor# Activating Deactivating
Returns Present Motors | On The 2-Axis Slave Commutation
Ring
$0 None None 1 Motor(2) . ServoCirlol | Motor(2) . Phasectelo
$1 1CO only 1-4 5 Motor[5].ServoCtrl=1 Motor[5].PhaseCtrl=0
(4 axes) Motor[6] .ServoCtrl=1 Motor[6] .PhaseCtrl=0
$3 ICO and IC1 1-8 9 Motor[9].ServoCtrl=1 Motor[9] .PhaseCtrl=0
(8 axes) Motor[10].ServoCtrl=1 Motor[10] .PhaseCtrl=0
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Motor Feedback
First, the user must make Encoder Conversion Table (ECT) entries on the Ring Controller to read the

feedback coming back from the ACC-24M2A on servo nodes. This applies to all feedback types that
ACC-24M2A uses.

Use the ECT entry type “Single (32-bit) register read), LSB Bit #: 8, # of Bits Used: 24. Make sure to
select the address based on the correct nodes enabled for this ACC-24M2A. One can set up the ECT entry
using the Power PMAC IDE by clicking (from within the software) on Delta Tau—>Configure—>Encoder
Conversion Table, showing this window:

ECT Setup: Online[192.168.0.200:55H] (=]
e 1 = Display All ECT Entries
Type ECT entry input 0
1: Single (32-bit) reqgister read -
e ECT entry ocutput 0

Detailed ECT Setup | PowerPMAC Structure | Encoder Plot |
ECT entry 1 details
Source Address  AccSE3[0] MacroInA[0][0].2

4

LSE Bit# 8 - Integrate? No -
# of Bits Used 24 = Integrator Bias Term 0
Result Units per LSB 0.03125 Limited Quantity None -
Limit Magnitude 0
# of Cycles to Limit 1
Number Type  pEnc pEncl MaxDelta g
_- AccSE3[0LMacrolnA0IDLa e -
AccBE3I01.MacrolnAl11[01.a Svs pushm 1]
3 'I AcchE3I01.MacrolnAl41[01.a Sys.pushm 1]
4 1 AcchE3[01. MacrolnAISI0.a Sys.pushm 1]
5 1 AcchE3[01. MacrolnAlSI0.a Sys.pushm 1] -
4 T | b
ECT entry 1 type 1: Single (32-bit) register read -

Function myDEUtIIFunctions.GetHWCardsList() did not detect any channel. Something is wrong either in PowerPMAC or with Database utility.
Setting number of channels to 4 (Default) ml
ECT entry 1 type 1: Single (32-bit) register read |

The only field the user needs to change on this screen is the Source Address and the Entry Number. There
should be one entry for each motor, each using the Source Address that corresponds to the node used for
this motor. That is, make the Source Address match the address of the feedback register of this motor’s
node. Make the Entry Number whatever is desired as long as it does not conflict with an ECT entry
currently used for another motor.

For Gate3-Style MACRO interfaces, use Gate3[i].MacrolnA[j][0].a for the encoder feedback Source
Address. For Gate2-Style interfaces, use Gate2[i].Macro[j][0].a.
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Example: Motors 1-2 on Nodes 0 and 1, respectively, with a Gate3-Style MACRO Interface on card

index 0

EncTable[1]
EncTable[1]
EncTable[1]
EncTable[1]
EncTable[1]
EncTable[1]
EncTable[1]

EncTable[2]
EncTable[2]
EncTable[2]
EncTable[2]
EncTable[2]
EncTable[2]
EncTable[2]

.pEnc=Gate3[0] .MacroInA[0] [0].a;
.pEncl=Sys.pushm;

.Index1=8;

.Index2=8;

.Index3=0;

.Index4=0;

.ScaleFactor=1/exp2 (EncTable[1l].Indexl + 5);

.pEnc=Gate3[0] .MacroInA[1l][0].a;
.pEncl=Sys.pushm;

.Index1=8;

.Index2=8;

.Index3=0;

.Index4=0;

.ScaleFactor=1/exp2 (EncTable[2].Indexl + 5);

Then, point this motor’s Motor[x].pEnc (position feedback pointer) and Motor[x].pEnc2 (velocity
feedback pointer) to the numerical hex value Processed Data Address listed the ECT window shown
above. The user must also set the Encoder Type (Motor[x].EncType) to 4.

Example: Motors 1-2 Motor[x].pEnc and Motor[x].pEnc2 setting:

Motor[1l] .pEnc=EncTable[l].a;

Motor

Motor

[1] .pEnc2=EncTable[l].a;
Motor[2] .pEnc=EncTable[2].a;
[2] .pEnc2=EncTable[2].a;

Motor[1l] .EncType=4;
Motor[2] .EncType=4;

Typically, Motor[x].pEnc and Motor[x].pEnc2 point to the same address. However, if the user wants to
use dual feedback on ACC-24M2A and is therefore using both encoder channels for one motor, the user
must make one ECT entry for each encoder and point Motor[x].pEnc to the position encoder’s ECT
entry’s output address and Motor[x].pEnc2 to the velocity encoder’s ECT entry’s output address.
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Digital A Quad B
The user must configure the Encoder Conversion Table on the ACC-24M2A itself as follows:

Example: ACC-24M2A with two motors, one on Node 0, one on Node 1

// ACC-24M2A ECT Setup for Quadrature Encoders
MacroSlave0,MI120=$0C090 // 1/T Extension of Incremental Encoder Chl
MacroSlave(0,MI121=5$0C098 // 1/T Extension of Incremental Encoder Ch2

// ACC-24M2A ECT Output Setup
MacroSlave0,MI101=$10 // Output from 1°° line of ECT (MI120)
MacroSlave0,MI102=$11 // Output from 2" line of ECT (MI121)

If the user wants to change the direction of the encoder feedback, he or she can either:
e Swap the motor’s leads
e Change MacroSlave<node>, M1910:
If M1910=3, set it to 7 (clockwise rotation is positive)
If M1910=7, set it to 3 (counterclockwise rotation is positive)

Sinusoidal
The user must configure the Encoder Conversion Table on the ACC-24M2A itself as follows:

Example: ACC-24M2A with two motors, one on Node 0, one on Node 1

// ACC-24M2A ECT Setup for Sinusoidal Encoders

// Channel 1

MacroSlave0Q,MI120=$F0C090 // Data Source Address location
MacroSlave0,MI121=$FF00 // A/D Converter Address Setup
MacroSlave0,MI122=0 // Sine/Cosine Bias -User Input

// Channel 2
MacroSlave0,MI123=$F0C098 // Data Source Address location
MacroSlave0,MI124=$FF20 // A/D Converter Address Setup

MacroSlave0,MI125=0 // Sine/Cosine Bias -User Input
// ACC-24M2A ECT Output Setup

MacroSlave0,MI101=$12 // Output from 3*® line of ECT (MI122)
MacroSlave(0,MI102=$15 // Output from 6" line of ECT (MI125)

Note that the third line of the entry for each channel (in this example, M1122 for Channel 1 and M1124 for
Channel 2) contains the bias in the A/D converter values. The user should enter into this line (indicated by
“—User Input” in the comment of that line) the value that the A/D converters report when they should
ideally report zero. The MACRO Station subtracts this value from both A/D readings before calculating
the arctangent. Many users will leave this value at 0, but to remove the offsets of single-ended analog
encoder signals is particularly useful. If it appears that the encoder has an offset, the user can compensate
for it in these variables. This line is scaled so that the maximum A/D converter reading provides the full
value of the 24-bit register (+/-22). Generally, it is set by reading the A/D converter values directly off of
the Station as 24-bit values (in this example, from Y:$C090 for Channel 1 and from Y:$C098 for Channel
2), computing the average value over a cycle or cycles, and entering this value here.

For more detail on how Sinusoidal Interpolation works in PMAC, see Appendix D.

motor/encoder shaft by hand and see encoder counts in the position

At this point of the setup process, you should be able to move the
=
window

Note
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SSI

ACC-24M2A can be configured to process SSI encoder feedback as a binary parallel word in 12, 16, 20,
or 24-bit format. As with all feedback, this data is transferred across the MACRO ring to be used as
position and/or velocity feedback. Each SSI device requires three lines of the ECT.

In the second line of each SSI ECT entry, the number of bits to process is specified. So, there are four
examples given below.

In the third line, specify the maximum change per servo cycle of the encoder counts that is expected. This
is typically equal to 1.25 times the maximum expected velocity of the motor. The units of this entry

are whatever the units of the input register are, typically 1/32 of a count. For example, to limit the change
in one servo cycle to 64 counts with an input register in units of 1/32 count, this third line would be 64*32
=2048.

In the examples below, the user must specify the maximum count change per servo cycle on the lines
which end with “-User Input” in the comments.

Example: ACC-24M2A with two motors, each with a 12-bit SSI encoder, one on Node 0, one on
Node 1

#define MaxVelChl 0 // Maximum count change per servo cycle, Channel 1 -User Input
#define MaxVelCh2 0 // Maximum count change per servo cycle, Channel 2 -User Input

// ACC-24M2A ECT Setup

//Channel 1

MacroSlave0,MI120=$30FF54 // Data Source Address location
MacroSlaveQ,MI121=S000FFF // 12-bit SSI conversion
MacroSlave0O,MI122=MaxVelChl*32

//Channel 2

MacroSlave0,MI123=$30FF74 // Data Source Address location
MacroSlaveQ,MI124=S000FFF // 12-bit SSI conversion
MacroSlave0O,MI125=MaxVelCh2*32

// ACC-24M2A ECT output setup
MacroSlave0,MI101=$12 // Output from 3°® line of ECT (MI122)
MacroSlave(0,MI102=$15 // Output from 6" line of ECT (MI125)

Example: ACC-24M2A with two motors, each with a 16-bit SSI encoder, one on Node 0, one on
Node 1

#define MaxVelChl 0 // Maximum count change per servo cycle, Channel 1 -User Input
#define MaxVelCh2 0 // Maximum count change per servo cycle, Channel 2 -User Input

// ACC-24M2A ECT Setup

//Channel 1

MacroSlave0,MI120=$30FF54 // Data Source Address location
MacroSlave(O,MI121=$00FFFF // 16-bit SSI conversion
MacroSlave0O,MI122=MaxVelChl*32

//Channel 2

MacroSlave(O,MI123=$30FF74 // Data Source Address location
MacroSlave(Q,MI124=S00FFFF // 16-bit SSI conversion
MacroSlave0O,MI125=MaxVelCh2*32

// ACC-24M2A ECT output setup
MacroSlave0,MI101=$12 // Output from 3*® line of ECT (MI122)
MacroSlave0,MI102=$15 // Output from 6™ line of ECT (MI125)
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Example: ACC-24M2A with two motors, each with a 20-bit SSI encoder, one on Node 0, one on

Node 1

#define MaxVelChl
#define MaxVelCh2

// ACC-24M2A ECT Setup
//Channel 1

0 // Maximum count change per servo cycle, Channel 1 -User Input
0 // Maximum count change per servo cycle, Channel 2 -User Input

MacroSlave0,MI120=$30FF54 // Data Source Address location
MacroSlave0,MI121=S0FFFFF // 20-bit SSI conversion
MacroSlave0,MI122=MaxVelChl*32

//Channel 2

MacroSlave0,MI123=$30FF74 // Data Source Address location
MacroSlave(Q,MI124=$0FFFFF // 20-bit SSI conversion
MacroSlave(0,MI125=MaxVelCh2*32

// ACC-24M2A ECT output setup

MacroSlaveQ,MI101=$12
MacroSlaveQ,MI102=$15

// Output from 3™ line of ECT (MI122)
// Output from 6™ line of ECT (MI125)

Example: ACC-24M2A with two motors, each with a 24-bit SSI encoder, one on Node 0, one on

Node 1

#define MaxVelChl
#define MaxVelCh2

// ACC-24M2A ECT Setup
//Channel 1

0 // Maximum count change per servo cycle, Channel 1 -User Input
0 // Maximum count change per servo cycle, Channel 2 -User Input

MacroSlave0O,MI120=$30FF54 // Data Source Address location
MacroSlave(Q,MI121=$SFFFFFF // 24-bit SSI conversion
MacroSlave(0,MI122=MaxVelChl*32

//Channel 2

MacroSlave(Q,MI123=$30FF74 // Data Source Address location
MacroSlave0O,MI124=$FFFFFF // 24-bit SSI conversion
MacroSlave0O,MI125=MaxVelCh2*32

// ACC-24M2A ECT output setup

MacroSlaveQ,MI101=$12
MacroSlaveQ,MI102=$15

// Output from 3*® line of ECT (MI122)
// Output from 6™ line of ECT (MI125)

If the direction decode variable, MacroSlave<node>, M1910, is
changed the user must save the setting, MSSAVE{node} and reset the
card MS$$${node} before the fractional direction sense matches.

Note
At this point of the setup process, you should be able to move the
= motor/encoder shaft by hand and see encoder counts in the position
window
Note
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Resolver

ECT Setup

ACC-24M2A has up to two channels of resolver inputs. The inputs may be used as feedback or master
reference signals for the PMAC servo loops. The basic configuration of the drive contains one 10-bit fixed
resolution tracking resolver-to-digital (R-to-D) converters, with an optional second resolver when a dual
axis driver is ordered. ACC-24M2A creates the AC excitation signal (ResOut) for up to two resolvers,
accepts the modulated sine and cosine signals back from these resolvers, demodulates the signals and
derives the position of the resolver from the resulting information, in an absolute sense if necessary.

The specifics for this configuration are as follows (Chl and Ch2):

Example: ACC-24M2A with two motors, each with a resolver, one on Node 0, one on Node 1,
wherein the clockwise direction of the motor’s shaft’s rotation is positive

// ACC-24M2A ECT Setup

// Channel 1

MacroSlaveQ,MI120=SEOFF00 // Data Source Address location ,CW
MacroSlave0,MI121=$00FF5C // A/D Converter Address Setup
MacroSlave0,MI122=0 // Sine/Cosine Bias -User Input

// Channel 2 CW

MacroSlaveQ,MI123=SEOFF20 // Data Source Address location, CW
MacroSlave0,MI124=$00FF5C // A/D Converter Address Setup
MacroSlave0,MI125=0 // Sine/Cosine Bias -User Input

// ACC-24M2A ECT Output Setup
MacroSlave0,MI101=$12 // Output from 3°® line of ECT (MI122)
MacroSlave0,MI102=$15 // Output from 6 line of ECT (MI125)

Example: ACC-24M2A with two motors, each with a resolver, one on Node 0, one on Node 1,
wherein the counterclockwise direction of the motor’s shaft’s rotation is positive

// ACC-24M2A ECT Setup

// Channel 1

MacroSlave0,MI120=$E8FF00 // Data Source Address location ,CCW
MacroSlave0,MI121=$00FF5C // A/D Converter Address Setup
MacroSlave0,MI122=0 // Sine/Cosine Bias -User Input

// Channel 2 CW

MacroSlave0,MI123=$E8FF20 // Data Source Address location, CCW
MacroSlave0,MI124=$00FF5C // A/D Converter Address Setup
MacroSlave0,MI125=0 // Sine/Cosine Bias -User Input

// ACC-24M2A ECT Output Setup
MacroSlave0,MI101=$12 // Output from 3°® line of ECT (MI122)
MacroSlave(0,MI102=$15 // Output from 6" line of ECT (MI125)

Note that the third line of the entry for each channel (in this example, M1122 for Channel 1 and M1124 for
Channel 2) contains the bias in the A/D converter values. This line (indicated by “-User Input” in the
comments on that line) should contain the value that the A/D converters report when they should ideally
report zero. The MACRO Station subtracts this value from both A/D readings before calculating the
arctangent. Many users will leave this value at 0, but it is particularly useful to remove the offsets of
single-ended analog encoder signals. If it appears that the encoder has an offset, the user can compensate
for it in these variables. This line is scaled so that the maximum A/D converter reading provides the full
value of the 24-bit register (+/-2%). Generally, it is set by reading the A/D converter values directly as 24-
bit values (in this example, from Y:$C090 for Channel 1 and from Y:$C098 for Channel 2), computing
the average value over a cycle or cycles, and entering this value here.
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changed the user must save the setting, MSSAVE{node} and reset the

If the direction decode variable, MacroSlave<node>, M1910, is
A@
card MS$$${node} before the fractional direction sense matches.

Note

Configuring Excitation Frequency
After setting up the ECT, the user then must set three MI-Variables for the Resolvers to function
correctly.

The ResOut signal (i.e. the Resolver’s excitation frequency) emitted from the ACC-24M2A is derived
from the Phase Clock frequency of the MACRO set by M1992 and M1997. The user has the ability to
select the excitation frequency to be equal with the Phase Clock frequency (default) by setting
MacroSlave<node>,M1982 equal to 0. Or, the user can use lower frequencies by increasing the value of
M1982.

M1982 affects the excitation frequency as follows:

M1982 Setting Excitation Frequency
M1982=1 (Phase Clock Frequency)/2
M1982=2 (Phase Clock Frequency)/4
M1982=3 (Phase Clock Frequency)/6

Configuring the Excitation Signal’s Gain

Additionally, the user needs to set the Excitation output gain for the system’s resolvers by setting
MacroSlave<node>,M1981.

MI981 affects the excitation signal’s gain as follows:

MI1981 Setting Excitation Signal Gain
M1981=0 2.5V,
MI1981=1 5.0 Vi
M1981=2 7.5V
M1981=3 10.0 Vo,
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Configuring the Excitation Signal’s Phase Offset

Finally the resolver excitation phase time offset, MacroSlave<node>, M1980, needs to be set. The
optimum setting of M1980 depends on the L/R time constant of the resolver circuit. Therefore, M1980
should be set interactively to maximize the magnitudes of the feedback ADC values.

For each channel, there are two ADC registers which hold the sin and cosine values. For Channel 1, the
base/first ADC register address is Y:$FF00 and the second ADC register address is Y:$FF01; For
Channel 2, the base/first ADC register address is Y:$FF20 and the second ADC register address is
Y:$FF21. There is no MI-Variable to directly address these registers, so M1198 (Direct Read/Write Format
and Address) and MI1199 (Direct Read/Write Variable) will be used here. For each channel, both ADCs
should be observed during setup. Notice that M1199 can only be pointed to one register at one time so it
must be configured twice throughout the following procedure.

Procedure for Configuring M1980 on Channel 1
The procedure for configuring MI1980 for Channel 1 is as follows:

9. Inthe Power PMAC IDE, open a Watch Window (click Delta Tau—>View—>Watch).

10. Into a field in the Watch Window, type MacroSlave<node>,M1199, where <node> is the node
number of this ACC-24M2A’s motor (e.g. if this motor is on Node 0, type MacroSlave0,M1199).

11. In the Terminal Window (from within the IDE, click Delta Tau->View-> Terminal), type
MacroSlave<node>,MI1198=$6DFF00, where <node> is this motor’s node (as in step 2). This
points MI199 to the Channel 1’s ADCI.

12. Rotate the motor on this channel. Observe MacroSlave<node>,M1199 in the Watch Window. If
it saturates to £32767, the resolver gain (MI1981) is too high. Decrease M1981 until the MI1199 just
barely saturates to £32767. If it does not saturate, type MacroSlave<node>,MI1198=$6DFFO01 in
the Terminal Window (which sets MI1199 to point to Channel 1°’s ADC2) and then repeat step 4.

13. Set MI1199 to point to the ADC which saturated; that is, if ADC1 saturated, type
MacroSlave<node>,MI1198=$6DFFO00 in the Terminal Window, or if ADC2 saturated, type
MacroSlave<node>,MI1198=$6DFFO01 in the Terminal Window.

14. Position the motor’s shaft such that the ADC value is close to the maximum value observed
throughout one revolution of the motor’s shaft. At this point, the other ADC should be close to 0.

15. Increase M1980 by increments of 25. The ADC value should start to increase slowly. If it
decreases, instead start with M1980=255 and then decrease M1980 by increments of 25. The ADC
value should increase up to a maximum point and then start to decrease again. Set M1980 to the
value that produced the largest absolute ADC value achieved throughout the process of adjusting
M1980.

16. If the maximum absolute value of this ADC is less than 16,000, increase the gain of the resolver
by increasing M1981.
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Procedure for Configuring M1980 on Channel 2
The procedure for configuring MI1980 for Channel 2 is as follows:

9.

10.

11.

12.

13.

14.

15.

16.

In the Power PMAC IDE, open a Watch Window (click Delta Tau->View->Watch Window).
Into a field in the Watch Window, type MacroSlave<node>,M1199, where <node> is the node
number of this ACC-24M2A’s motor (e.g. if this motor is on Node 0, type MacroSlave0,M1199).
In the Terminal Window (from within the IDE, click Delta Tau—>View-> Terminal), type
MacroSlave<node>,M1198=$6DFF20, where <node> is this motor’s node (as in step 2). This
points MI199 to the Channel 1’s ADCI.

Rotate the motor on this channel. Observe MacroSlave<node>,M1199 in the Watch Window. If
it saturates to £32767, the resolver gain (MI1981) is too high. Decrease M1981 until the MI1199 just
barely saturates to +32767. If it does not saturate, type MacroSlave<node>,MI1198=$6DFF21 in
the Terminal Window (which sets MI199 to point to Channel 1°’s ADC2) and then repeat step 4.
Set MI199 to point to the ADC which saturated; that is, if ADC1 saturated, type
MacroSlave<node>,M1198=$6DFF20 in the Terminal Window, or if ADC2 saturated, type
MacroSlave<node>,MI1198=$6DFF21 in the Terminal Window.

Position the motor’s shaft such that the ADC value is close to the maximum value observed
throughout one revolution of the motor’s shaft. At this point, the other ADC should be close to 0.
Increase M1980 by increments of 25. The ADC value should start to increase slowly. If it
decreases, instead start with M1980=255 and then decrease M1980 by increments of 25. The ADC
value should increase up to a maximum point and then start to decrease again. Set M1980 to the
value that produced the largest absolute ADC value achieved throughout the process of adjusting
M1980.

If the maximum absolute value of this ADC is less than 16,000, increase the gain of the resolver
by increasing M1981.

At this point of the setup process, you should be able to move the
= motor/encoder shaft by hand and see encoder counts in the position

window

Note
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Flags
On the Ring Controller, the motors’ flag pointers must point to the servo node’s flag addresses used for
the motors on ACC-24M2A.

Example: Motors 1-2 on Nodes 0 and 1, respectively, using ACC-5E3 in a Power UMAC

Motor[1l] .pEncCtrl=Accb5E3[0] .MacroOutA[0][3].a
Motor[1l] .pEncStatus=Acc5E3[0] .MacroInA[0][3].a
Motor[1l] .pAmpEnable=Acc5E3[0] .MacroOutA[0][3].a
Motor[1l] .pAmpFault=Accb5E3[0] .MacroInA[0][3].a
Motor[1l] .pCaptFlag=Accb5E3[0] .MacroInA[0][3].a
Motor[1l] .pPhaseEnc=Accb5E3[0] .MacroInA[0] [0].a
Motor[1l] .pAdc=Acc5E3[0] .MacroInA[0][1].a

Motor[2] .pEncCtrl=Acc5E3[0] .MacroOutA[1l][3].a
Motor[2] .pEncStatus=AccbE3[0] .MacroInA[l][3].a
Motor[2] .pAmpEnable=Acc5E3[0] .MacroOutA[1l][3].a
Motor[2] .pAmpFault=Acc5E3[0] .MacroInA[l][3].a
Motor[2] .pCaptFlag=Acc5E3[0] .MacroInA[1l] [3].

]
Motor[2] .pPhaseEnc=Acc5E3[0] .MacroInA[1][0].
Motor[2] .pAdc=AccbE3[0] .MacroInA[l][1l].a

Then, on the Ring Controller, the flag control variables must be set up for each motor on ACC-24M2A.

Example: Motors 1-2 on Nodes 0 and 1, respectively, with overtravel limits enabled, using ACC-
5E3 in a Power UMAC

Motor[l].pLimits=AccbE3[0].MacroInA[0][3].a

Motor[1l].LimitBits=25
Motor[1l].CaptPosRound=1
Motor[1l].CaptPosRightShift=0
Motor[l] .CaptPosLeftShift=13
Motor[l].CaptFlagBit=19
Motor[1l] .AmpFaultBit=23
Motor[1l] .AmpEnableBit=22
Motor[1l] .AmpFaultLevel=0
Motor[2] .pLimits=Acc5E3[0] .MacroInA[l] [3].a
Motor[2] .LimitBits=25
Motor[2] .CaptPosRound=1
Motor[2] .CaptPosRightShift=0
Motor[2] .CaptPosLeftShift=13
Motor[2] .CaptFlagBit=19
Motor[2] .AmpFaultBit=23
Motor[2] .AmpEnableBit=22

[2]

.AmpFaultLevel=0
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Example: Motors 1-2 on Nodes 0 and 1, respectively, with overtravel limits disabled

Motor[1l] .pLimits=0;
Motor[1l].LimitBits=25
Motor[1l].CaptPosRound=1
Motor[l].CaptPosRightShift=0
Motor[1l] .CaptPosLeftShift=13
Motor[1l].CaptFlagBit=19
Motor[1l].AmpFaultBit=23
Motor[1l] .AmpEnableBit=22
Motor[1l].AmpFaultLevel=0

Motor[2] .pLimits=0;

Motor[2] .LimitBits=25
Motor[2] .CaptPosRound=1
Motor[2].CaptPosRightShift=0

Motor[2].CaptPosLeftShift=13
Motor[2].CaptFlagBit=19
Motor[2] .AmpFaultBit=23
Motor[2] .AmpEnableBit=22
Motor[2] .AmpFaultLevel=0

Output Commands
On the Ring Controller, the output command address must be set to the ACC-24M2A’s motors’ servo
node addresses directly.

Example: Motors 1-2 on Nodes 0 and 1, respectively, using ACC-5E3 in a Power UMAC

Motor[1l] .pDac=AccbE3[0] .MacroOutA[0] [0].a;
Motor[2] .pDac=AccbE3[0] .MacroOutA[1l] [0].a;

These examples configure only motors 1-2. If you are configuring
(foa other motors, refer to the Power PMAC Software Reference Manual

ot for the different settings the aforementioned structures can take.
ote
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I°T Settings

The I°T overcurrent protection should be configured for each motor on ACC-24M2A. Below is an
example with some formulas for setting up 1°T; the user simply needs to fill in the values specified by
“-User Input” in the comments on that line:

Example: Configuring 1°T Protection for Motors 1-2

#define AxislMinContCurrent 3 ; Continuous Current Limit for Axis 1 [Amps] -User Input
#define AxislMinPeakCurrent 9 ; Instantaneous Current Limit for Axis 1 [Amps] -User Input
#define AxislAmpPeakInstCurrent 16.3 ; Peak Instant. Current of Amplifier [Amps] -User Input
#define AxislI2TOnTime 2 ; Time allowed at peak current [sec]

// Assuming that motor 1 is the first motor on MACRO

Motor([1]
Motor([1]
Motor([1]

Motor([2]
Motor([2]
Motor[2]

.I2TSet=32767*AxislMinContCurrent/AxislAmpPeakInstCurrent
.MaxDac=32767*AxislMinPeakCurrent/AxislAmpPeakInstCurrent
.I2TTrip=(Motor[1l] .MaxDac*Motor[1l].MaxDac - Motor[l].I2TSet*Motor[l].I2TSet +

Motor[1l].IdCmd*Motor[1].IdCmd) *Axis1I2TOnTime

.I12TSet=Motor[1].I2TSet // Assumes motor 2 is the same as motor 1
.MaxDac=Motor[1l].MaxDac // Assumes motor 2 is the same as motor 1
.I2TTrip=Motor([1].I2TTrip // Assumes motor 2 is the same as motor 1

The continuous current limit (Axis1MinContCurrent) and the instantaneous current limit
(Axis1MinPeakCurrent) values on the lines with “-User Input” in the comment above should be the
smaller of the two limits between your motor and your amplifier’s specifications.

DAC Calibration

Before performing the DAC Calibration, make sure there is no
load attached to the motor, and make sure that the motor can
safely and freely move. This step of the setup can generate much

WARNING motion in the motor.

At this stage in the setup, the user should calibrate the DACs on ACC-24M2A to make sure that when he
or she commands 0 volts on the DACs, they actually put out 0 volts. You can do this by means of the
automatic DAC calibration program from the Power PMAC System Setup program, easily accessible by

means of a TelNet Terminal connection to your PMAC. To open a TelNet connection, from the Windows
Start Menu click Start->Run (or just type into the search field if it is Windows Vista/7) and then type:

telnet 192.168.0.200

Put your Power PMAC’s IP Address in the place of 192.168.0.200 (the default IP address) shown above.
TelNet will prompt you for a “powerpmac login”; here type:

root

The password is:

deltatau

Then, type:

cd setup

dir
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calcdacbias should appear as a program in the list. This is a program that receives two arguments as
follows:

calcdacbias <MotorNumber> [<Iterations>]

<MotorNumber> is the number of the motor whose DAC bias you want to calculate. [<Iterations>] is the
number of times you want the program to iterate; more iterations generally yields a more accurate result.

Example
To calculate the DAC bias of motor 1 with 10 iterations, type:

calcdacbias 1 10

Once the program completes, it will issue a command to PMAC to change the DAC bias for this motor.
For example, after entering the above command, the final iteration of the program will print something to
the effect of:

Command: Motor[1].DacBias = -139.200000

You may want to write down this number and put it into your motor setup file in your project within the
Power PMAC IDE for future reference.
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Open Loop Test

Before performing the Open Loop Test, make sure there is no

load attached to the motor, and make sure that the motor can

safely and freely move. This step of the setup can generate much
WARNING motion in the motor.

The user should now execute an Open-Loop test in order to determine whether the feedback from ACC-
24M2A is working properly. To do this, open Tuning from the Power PMAC IDE by clicking on
Tools->Tune. Then, click the Open Loop Test button on the left:

o' Tune : Online[192.168.0.200:55H] = =R =
Cpen Loop 10/
Test Magnitude (%) =
Open Loop
Cpen Loop 100
Test Test Time {ms)
Mumber of -
Position Loop Repetiti 1=
Auto Tuning EuaLaE
Interactive Do Open Loop Step
Tuning Test
Trajectory
Prefiter Setup
Adaptive Select
Control Setup @ Step ) Sinuscidal () Sinesweep
 Motor#
1 =
Close Loop
Enable
COpen Loop
Enable
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You should see the actual velocity increasing positively while the commanded velocity is positive, the
actual velocity decreasing while the commanded velocity is negative, looking something like this:

o5 Power Pmac Tune: Motor1 Open Loop Test Move: 4/25/2012 9:48:23... EI@

File View Tools

Motor 1 Open Loop Test Move: 4/25/2012 9:48:23 AM

Servo Command (m unit)

o~
=
£
=
E

=1
=

=
ks
2
]
>

™
=]
o
<

200
Time {ms)

If you see an erratic response, or an inverted saw tooth, then most likely the encoder decode setting is
incorrect. To change this, change MS{node},M1910 for this motor from 7 to 3, or vice versa.
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Servo Loop Tuning

PMAC’s Servo Algorithm must be configured to properly control any given system with motors and
amplifiers. Configuration is done by adjusting setup structures pertaining to the PID gains. Friction
Feedforward is also needed. The servo loop gains correspond to structures as follows:

» Motor[x].Servo.Kp Proportional Gain (Kp)
» Motor[x].Servo.Kvfb Derivative Gain (Kq)
» Motor[x].Servo.Kvff Velocity Feedforward (Kys)
» Motor[x[.Servo.Ki Integral Gain (Kj)
» Motor[x].Servo.SwZvInt Integration Mode
» Motor[x].Kaff Acceleration Feedforward (Kss)
» Motor[x].Kfff Friction Feedforward (Kg)
A The user should connect the load to the motor before tuning the servo
(=2 loop.
Note

The process of determining proper values of PID gains is called “Tuning.” The procedure for tuning is as
follows:

4. Set Motor[x].Servo.SwZvInt (Motor xx PID Integration Mode) — can be changed on the fly as
needed
=1, position error integration is performed only when Motor xx is not commanding a move
=0, position error integration is performed always

5. Using the Step Response, tune the following parameters in this order:
Proportional Gain, Kp (Motor[x].Servo.Kp)
Derivative Gain, Kd (Motor[x].Servo.Kvfb)
Integral Gain, Ki (Motor[X[.Servo.Ki)

6. Using the Parabolic Move, tune the following parameters in this order:
Velocity Feedforward, Kvff (Motor[x].Servo.Kvff)
Acceleration Feedforward, Kaff (Motor[x].Kaff)
Friction Feedforward, Kfff (Motor[x].Kfff)

e When tuning the feedforward gains, set
Motor[x].Servo.SwZvInt =1 so that the dynamic behavior of

the system may be observed without integrator action. After
A tuning these, set Motor[x].Servo.SwZvlInt back to your
B desired setting.
Note e Setting Kvff = Kd (Motor[x].Servo.Kvff =
Motor[x].Servo.Kvfb) is a good place to start when tuning
Kvff.
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Steps 2 and 3 should be performed in the Interactive Tuning window in Tuning:

P

@ Tune: Online[192.168.0.200:55H]

(=[]

Cpen Loop
Test

Postion Loop
Auto Tuning

Postion Loop
Interactive
Tuning

Trajectory
Prefiter Setup

Adaptive
Control Setup

Mator #

T e

Close Loop

Enable

Cpen Loop
Enable

Present Gain View

Propartional Gain
Derivative Gain1
Derivative Gain2
Velocity Feed Forward 1
Velocity Feed Forward2
Integral Gain

Integral Mode

Accel. Feed Forward
Friction Feed Forward
Max Dac

Fatal F.E. Limit

Input DB Size

Input DB Gain

Cutput DB Inner
COutput DB Outer
Cutput DB Seed

[] Clear other non-zero servo loop parameters

40

40
0
9.99999572-5

=N N == I S === I g == |

Trajectory Selection

@ Posttion Step

Paosition Ramp
Parabolic Velocity
Trapezoidal Velocity
S{Curve Velocity
Sinusoidal

Sine Sweep

User Defined

Fitter Calculator

PID Diagram

Select the Motor Number here

Step Move
Step Size (mu) 1000

Step Time (ms) 500

]

Input the move size here

[ Kill Motor After Step Maove

[T] Move in one direction

Plot Axis
Left Auds Plot

[Position

Right s Flot

[Senrn Command

Step 2 (tuning K,, Kq, and Kj)
Select “Position Step” under “Trajectory Selection.” Choose a “Step Size” (under “Step Move”) that is
within ¥ to ¥ of a revolution of the motor if it is a rotary motor, or within % to ¥% of one electrical cycle if
it is a linear motor. The step move’s commanded position profile should look somewhat like this:

Commanded
Position [cts]

Time [sec]

Now, compare your motor’s actual position to the commanded position profile. Depending how the actual
position looks, adjust the servo loop gains until you achieve the desired response.
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Observing the table below, match your actual position response to one of the response shapes below, and
then adjust the appropriate gain as listed next to each plot:

Overshoot and
Oscillation
Cause:

Too much Proportional
gain or
too little Damping
Fix:
Decrease K,
Increase Ky

Sluggish Response
Cause:

Too much Damping or
too little Proportional
gain
Fix:

Increase K, or

Decrease Kg

Position Offset
Cause:
Friction or Constant
Force
Fix:
Increase K;
Increase K,

Physical System
Limitation
Cause:

Limit of the
Motor/Amplifier/Load
and gain combination
Fix:

Evaluate Performance
and
maybe add K,

Typically, one should start by increasing K, until one observes the “Overshoot and Oscillation” condition
(upper left corner’s plot), and then increase K4 and K; until the performance goals for the step response
are achieved. Be sure when executing the step response that you plot the Servo Command on the Right

AXis (see image on right below).

If you see a truncation of the
servo command at the
beginning of each move, you
have reached the maximum
output command as determined
by Motor[x].MaxDac. In this
case, adding more K, will not
improve the Step Response’s
performance.

a5 Tune : Online[192.168.0.200:55H]

Open Loop
Test

Position Loop
Auto Tuning

Position Loop

Interactive
Tuning

Trajectory
Prefilter Setup

Adaptive
Contral Setup
Motor £
1 =

Kill

Open Loop
Enable

Present Gain View Trajectory Selection

Propartional Gain 11224582

Desivative Gain1 2693.1138 @ Posttion Step

Denivative Gain2 0 Posttion Ramp

Velocity Feed Forward1 2693.1138 Parabolic Velocity

Velocity Feed Forward2 0 Trapezoidal Velocity

Integral Gain 0.0037762409 5-Curve Velocity

Integral Mode ] Sinusoidal

Accel. Feed Forward ~ 32817.238 Sine Sweep

Friction Feed Forward 0 User Defined

Max Dac 28000

Fatal F.E. Limit 2000

Input DB Size ] |
Fitter Calculator

Input DB Gain

Cutput DB Inner

Qutput DB Outer
Cutput DB Seed

= e e e

‘ PID Diagram ‘

Step Move
Step Size (mu) 1000

Step Time (ms) 500

Kill Mator After Step Move

Maove in one direction

Do a Step Move

Plot Axis
Left Auis Plat

| Fosition - |

Right Axis Plot

|Ser\to Command hd |

Clear other non-zero servo loop parameters
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Step 3 (Tuning K, Kasr, and Kfff)
Select “Parabolic Velocity” under the “Trajectory Selection” in the Interactive Tuning Window. Select a
move size and speed that will simulate the fastest, harshest moving conditions you expect your machine
to experience. Tune the motor at these settings, and then the motor should be able to handle all easier

moves.

After commanding the Parabolic Velocity move, the commanded Velocity Profile and Acceleration
Profile should look like this:

Velocity
Commanded
Profile

N\

4

Acceleration
Commanded
Profile

Observing the table below, match your actual position response to one of the response shapes below, and

then adjust the appropriate gain as listed next to each plot:

High Vel ./F.E.
Correlation
Cause: Damping
Fix: Increase Ky

High Acc./F.E.
Correlation
Cause: Inertial Lag
Fix:
Increase K

N\

-
/|

High Vel./F.E.
Correlation
Cause: Friction
Fix:

Add K
and/or turn on Integral
Gain (Kj)

High Acc./F.E.
Correlation
Cause:
Physical System
Limitation
Fix:

Use softer acceleration
or add more K

Configuring with Power PMAC
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Negative Vel./F.E.
Correlation
Cause:

Too much Velocity
Feedforward

Fix:

Decrease Ky

Negative Acc./F.E.

Correlation
Cause:

Too much
Acceleration
Feedforward
Fix:

Decrease K

High Vel ./F.E.
Correlation

Cause: Damping &
Friction

Fix:

Increase K first
Possibly adjust Kg

High Vel./F.E. &
Acc./F.E.
Correlation
Cause:

Inertial Lag &
Friction

Fix:

Increase K¢
Possibly adjust Ky

Configuring with Power PMAC
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LAYOUT
=~ 2.000 =
— 1000 —, | — .1s8
N [1651] [05.4] 6 [4.76]
& u
625 °©
[15.881 I
L
9,730 8,625 33735
[247.7] [2191] [238.131]
o [ =
o
]
o :
e | [
| o
1,250
200
(1271 [31.75]
All main dimensions are in units of inches (millimeters are in square brackets).
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APPENDIX A: JUMPERS

Jumper Name Description Default
EO Lattice Download Remove jumper to disable ability to perform Lattice
Download. _ Not
@ @ Jump pins 1 and 2 to enable ability to download. jumpered
E1l Watchdog Timer Remove jumper to enable Watchdog Timer.
Disable Jump pins 1 and 2 to disable Watchdog Timer (for test ) Not
@ @ purposes only) jumpered
E2 CPU Mode Jump pins 1 and 2 for firmware download through USB port.
| @ @ @ Operation/Bootstrap | Jump pins 2 and 3 for normal operation. Pin 2-3
E3 Buffer Request Remove jumper to allow BRSEL- to 5Vdc
Select Polarity Jump pins 1 and 2 to pull BRSEL - to 0Vdc Not
@ @ jumpered
E5 Encoder / Pulse and Remove jumper to enable +/-10V analog output on Chl
Direction Chl Jump pins 1 and 2 to enable Stepper mode output for Chl Not
@ @ jumpered
E6 Encoder / Pulse and Remove jumper to enable +/-10V analog output on Chl
Direction Ch2 Jump pins 1 and 2 to enable Stepper mode output on Ch2 Not
@ @ jumpered
E9 Stepper Drive Remove jumper to receive encoder C-Channel input on Ch1.
Amplifier Enable Jump pins 1 and 2 to provide Amp Enable line for Stepper ) Not
@ @ Chl Motor-style amplifier Ch1. jumpered
E10 Stepper Drive Remove jumper to receive encoder C-Channel input on Ch2.
Amplifier Enable Jump pins 1 and 2 to provide Amp Enable line for Stepper Not
@ @ Ch2 Motor-style amplifier Ch2. jumpered
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APPENDIX B: SCHEMATICS

MACRO Fiber Connection

+3.3VD +3,3VD
U35
1
c114 c115 2 Eé\iEE
0.1 uF 3
R37 01uF R38 7| RD-
68.1 68.1 L2l B 5| SD
= = I~ 5 RXVCC MACRO Over Fiber
122 FB 7| IXvee
5 TD-
9 TD+
TXVEE
HFBR-5803
R39 R40 C116|, Cc117 C118
187.0 187.0 == 3.3/5.0 Volt Fiber
10 uF 1 uF 1 uF Optic Transceiver
- - _?_ —_ = _?_ Analog Ground
LVPECL Termination Network Located
at Optical Transceiver Inputs TD+/TD-
(NEAR U35 HFBR-5803)
+3,3VD +3,3VD
R42
4,99K:
[ N
[
€403
1UF
R44 R70 < R71
7.5K 82 82
LVPECL Termination Network Located
at Ethernet Transceiver Inputs
FXR+/FXR- (NEAR U31 AM79C874) OPT A - FIBER MACRO ONLY
MACRO RJ45 Connection
+3.3VD
U32 J4
49.9 ¢ 499 rj45s
Ja
16 1p. ™
15 _3 o or k2 | 2 E
e — e [ 2 ey o
==C111 13 4 1 B .
UF j:" ¢ I”-C- R61 R62 R63 RJ-45-8
12 5
= n.c. n.c. 5
1 bl Bl J
il — : ax 18 rj45s
ol bt L ol | J5
9 rps —2 R+ 2 .
4 4
4 wver Copper
—==C112 4 '?QZ’ZZ)SQ) core
R53 R54 1UF - 410
Rs3 < Rst I TG110-S050N2 an z
= R64 |R65 R66/R67|R68 RJ-45-8
106
1UF 51 51 51 [51 |51

109
01 UF (3KV)
Chassis Ground
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Limit Inputs

+gV
Rpzs "~
3.3KSIP10C
O 00| | | < N|
J U62A (SMT4 -
FLAG D1 l_(_ll USER1
2 FLAG_D1<S ‘31 Cl ACI1A ; ;1; RN 4 PLIML
El ACI1B 3 VLTV
PS2505L-INEC 7 EO%ETll
U628 (SMT4) T
FLAG B1 4 l_(_]l 1 4.7KSIPSI
2 FLAG_BL<K 31CL ACHA [ RP37 1
El ACI1B AR
B AA A
PS2505L-INEC 5
U62C (SMT4) 7 LIMITS 1,2
2 FLAG_C1<K FLAG C1 ‘31 Cl ACI1A é 4.7KsIP8I
El ACI1B 1 QP38 2 | USERL 1
PS2505L-INEC BEAAASTE PLIML 9
U62D_(SMT4) 5 % 2
FLAG Al T
2 FLAG_ALL: g Cl ACIA é ! FL RTL 2
El ACI1B X1KSIP8I BEOUT T
PS2505L-INEC - - (IN SOCKET) gLSIEMF;Z
= | = 1
g I MLIVZ
e I HOMEZ 1.
= FLR1Z
< < BEQUZ 1
b3} 3! RP39
1KSIP8I -
i
., _FLAG D2 P40 USER2
2 FLAG_D2<- g Cl ACIA % é PLIVZ GND
El ACI1B 5 MLIV2
PS2505L-INEC 7 mmz
FLRTZ
4.7KsIP8I
FLAG_B2
2 FLAG_B2 < g Cl ACIIA % RP41
El ACI1B H— AN
AT &
PS2505L-INEC WA
2 FLAG Co (—THAC.C2 g Cl1 ACIIA % 4.7KSIP8I
ACI1B 1 RP42. 2
PS2505L-INEC RIS
5 6
FLAG_A2
2 FLAG_A24K g Cl ACIIA % L 8
1 ACIB . . X1KSIP8I
O PS2505L-INEC (IN SOCKED)
D — | =
S N
Bla|d
N Rl ]
(s} -0 L
— [}
ﬂT ﬁT Tesi
© © 1KSIP8I
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Digital Quadrature Encoder Inputs

U46A
74AC86
3 /74HC132 (SO14) 2
(SO14) 2
U478
R84 2.2K 4
74AC86
(SO14) 5
U468 \
5
) QL1 6,( 74HC132
2 QK (so1d) |4
c128
= .duf
(o]
GND
ua7C
u46C 10
10 74AC86
8 /74HC132 9
(SO14) 9
U47D
R85 2.2K 13
74AC86
(SO14) 12
U46D
12
QL 2 11.( 7aHC132
LRk 2 114
2 QL2 & (SO14) 13

C130

= .duf

(o]
GND

1 RPIS 5 CHAL+
3 4 CHAL
AN CHBLT
T N8 CHBL-
1KSIPS
+5V
c127 9
o .auf
GND
1 RPIE 5 CHA2+
3 4 CHAZ-
AN CHB2%
7 8 CHB2-
1KSIPSI
+5V
c129 9
o .auf
GND
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Pulse and Direction Outputs

us0
vee (8
2 pwmcem H—EWMCTL 14, outa |2
L3 |_ RP26 CHU1+ DIR_1+
JUMP "E5 1-TO-2 TO ENABLE STEPPER#1 OUT 1o g502 Z 1 OUT-A 3 4 CHVI+ DIR I
JUMP "ES5 2-TO-3 TO ENABLE A-B QUAD#1 OUT " m L5 g:‘{r\iif ﬂt i;
2 PWMC_BL » PWM C B1 73 IN-C outc -2 33sIpal
2 PwMCT2 MHTWMCT2 154 N8 outs 4 RP27 CHU2+ DIR 2+
— 113 4 CHV2+ DIR
" - OouT-8 CHW2+ PUL 2-
SN "E6 2.00-5 0 EXABLE AL GUADAT OUT to gsol Heveo Ly _ll—_ CHTZ PO
33SIP8I
2 PWM.C B2 M—TWMC B2 1 IND outp (0
onp |2
ST34C87CF16 (SO16)
°F5__. PUL-DIR OUTPUT SECTION
2.2KSIP8I - e
GND Voo |28
27 AENA 1 3—AENAL 1 in-a ouTA (-2
— 13
JUMP "EO9" TO ENABLE AMP-ENA#2 1, 2 ENA_AEN1 4 OUT-A
0 E9 O EN-A,C STrE b5 FAULT L o oy g
ENC Bl 1 INc outc |2 L1 RP2s CHAL+
27 AENA 2 3—AENAZ 154 N8 outs 4 — ¢ S
ouTs pL2 Siltd
JUMP "E10" TO ENABLE AMP-ENA#2 161002 ENA_AEN2 12 1 N 33SIP8I
' oUTD p—x
ENC B2 . outD O FAULT 2 » pauLT 2
onp |2
7 ENAAENL & ST34C8TCF16 (SO16)
7 ENA_AEN2 ——— Cﬁﬁ
AUF
GND +5v
Hall Sensor Inputs
+5V
o
RP19 o
3.3KSIP10C
+5V
o
Uas O 00|~ O[O
Ul CHU1+
2 FLAG U1 El[ﬁg*\ﬂ ? Y1 AL % iRPZO CAVIF $$CHUL+
2 FLAG_V1 Y2 A2 [ CAWTF S CHVL+
FLAG_W1 6 4 5 6 CHW1+
2 FLAG_WI = V3 A3 £ CHTLF
FLAG_T1 5 5 7 81KSIP8| CHT1+
2  FLAG_T1 Y4 Ad CHUZ2+
FLAG_U2 4 6 1 2RP21 CHU2+
2 FLAG_U2 =— Y5 A5 CAVZT
FLAG_V2 3 7 3 4 CHV2+
2  FLAG_V2 Y6 A6 CHW?2+
FLAG_W2 2 8 5 6 CHW2+
2 FLAG W2SS—FTAG T2 i o 8IKSIP8] CHT2+
2 FLAG_T2 Y8 A8 CHT2+
20 1 vee 61 pd
0 6o 62 pe—oi
C125 c126|
74AC541
1UF (SOL20) AUF

@
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Position Compare Outputs
+8V

c123 1
J_ﬁ_. é R80
AUF o < 330

GND >

- N

EQU 1 2 U43A

2 EQU_1 >

DS7545INg]  (IN SOCKET)
(DIP8)

o
GND

e ) 5

BEQU2

U43B
2 EQU 2 H—E2 7 J

DS75451N
(DIP8)
(IN SOCKET)

1 RESET- >’>&
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Use 1.74K 1% for a 130°C allarm, 1.62K 1% for a 150°

Accessory 24M2A

2.23 V KTY84-130 @ 130°C
2.33 V KTY84-130 @ 150°C

Motor Thermal Inputs
+5VAN1
[}
R136
R131 R132 R137
k1% <1.74K 1% Cpt? 71.5K 1% 2.21K 1%
|
0.1UF ®
3 LM393AD .
t t
1in therm mot R130 R134 , |veoa>1 erm_mo
6  1lin_therm_mot ~(s08
100 1% 1K 1% L1 (S08)
< Has to be KTY84_130 and not KTY84_150
Dzsﬁ
SMAJ5.0 R133 _[C213 C214 R135
. 9 9
To J10 pin 23 Encoder connector 1.5K 1% o 1uF0.1uF 7.5K 1%
Note: USE NC contact as thermal sensor. PTC resistor KTY84-130 or similar
can be used. Different PIC type needs different R82 value.
Use 1.74K 1% for a 130°C allarm, 1.62K 1% for a 150°

o
AGND

+5VAN2
[e]

2.23 V KTY84-130 @ 130°C
2.33 V KTY84-130 @ 150°C

R141 R142
k1%  <1.74K 1%

R144

R146 R147
2.21K 1%
71.5K 1%
5 LM393AD
\ 7 2 therm mot
Has to be KTY84_130 and not KTY84_150

o

usoB
- on

1K 1%

2in_therm_mot
100 1%

@5mi_¥m Motor Thermal

D26 ﬁ
<R143

2in_therm_mot
SMAJ5.0

6

PTC resistor KTY84-130 or similar

R140
1.5K 1%—|alu,: 0_1u?|' 7.5K 1%
T Input 1&2

To J11 pin 23 Encoder connector
[}
AGND

Note: USE NC contact as thermal sensor.
can be used. Different PTC type needs different R82 value.
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SSI Inputs

+5V
o

ug2

VCC GND
ssi_iol

ena_ssi_outl J_

ROUT  _
RENA A

DENA
DIN A

(SQIC8)

W L\)I—‘ [o<]

ADM1485JR
c202 2 || 1

0.1uF 1 RR12

I
U83 0402

S AAN

ALTCOS1-

ALTCOS1+

VCC GND
Ssi_io2

8
3 ROUT  _
—O9 RENA A
ena_ssi_out2 J_ 3
4

DENA
DIN A

(SOIC8)

NN

ALTCOS2-

ssi i0l-
SSi 01+ gg
SSi_I02-

7

33SIP8I

ADM1485JR
c203 2 || 1

0.1uF

[
Us4 0402

VCC GND
X—;- ROUT  _
— =0 RENA A

ena ssi clkl 3
ssi_clk_outl 4

DENA
DIN A

(S0OIC8)

ADM1485JR

RP13

U85

C204I I.lUF

{ecl{o2] BN [N}

ALTCOS2+

SSTZF S

SS1
1&2

ALTSIN1-

ssi_clk_outl-

ALTSIN1+

ssi_clk_outl+

VCC GND
X—{ROUT  _
+—29RENA R

ena_ssi_clk2

3
ssi_clk_out2 4 | DENA
DIN A

(SOIC8)

ALTSIN2-

ssi_clk_out2-

~|O|W|—

33SIP8I

ADM1485JR

CZOSI I.lUF

[¢)
GND

Q0O |- N

ALTSIN2+

ssi_clk_out2+

ssi_iol-
ssi_iol+
Ssi_io2-
Ssi_io2+

(2N NerNer

ssi_clk_outl- 6
ssi_clk_outl+6
ssi_clk_out2- 6
ssi_clk_out2+ 6
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Resolver Outputs

+5V
(o]
0187 ®
D15
MMBD301LTL
3 U74A o
R108
ResOutl
R104 S 3> ResOutl
—AN, 100hm
4.99K mh6672ma ™
<|1t1497cs8
C188 D16
MMBD301LT1
R106 - v
4.99k ™
D17
MMBD301LTL
5 \‘%B o
+ R109
ResOut2
R105 5 L SERE 3 ResOut2
— / ™ 10ohm
4.99K imh6672ma
1t1497cs8 D18
R107 MMBD301LT1
/\ |
4.99k
Analog Feedback Voltage Reference Circuit
+5V_AN v
o
|, L4 BEAD,
U90 il
R331 100hm LT1963AEST-2.5
BVREF1
A 3 3 ouT 4 IN L
C249 < z c248
R333 100hm 47UF - .| _47UF
BVREF2 . 16V < SOT-223) -~ T~16V
VNV (TANT) | ) (TANT)
o
AGND
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Sin/Cos Inputs

s K R230 12.7K
ALTSIN1- ssi_clk_outl- 5 AD824AR
NN %
] ot
~r(S014)
R234
R236
27.4K = C243
27.4K 22pf
AGND
R231 12.7K
ALTSIN1+ ssi_clk_outl+
RP62
220SIP61
1 A A2
. SOCKET R232 12.7K
ALTCOS1- ssi_iol- ANAN - 10 ?‘A\D824§R
9 u91C
ot
R235
R237
27.4K — C244
27.4K 22pf
AGND
- R233 12.7K
ALTCOS1+ Ssi_iol+ AANA
Note: Sin/Cos inputs for Channel #2 are identical to Channel #1.
Encoder Power
+5V
o
1 1 A~
BEAD
L6
o 1 A2 .
o BEAD
enc owr 12 | 15 SOT23-5) c26ff C268 Kl 3
5  enc_pw_12 >>—’pﬁ'i: 20| Y% 1ot [t —%ﬁes o
NC75714M5 | EncPwrl
C266 o D34 I 10
= 9
T,
Auf MMBD301LT1 28  OEncPw2
— 1 a,
12 of
o FBR12NDO5
GND

Appendix B: Schematics



Accessory 24M2A

Sinusoidal Encoder Input

| SINUSOIDAL
| ENCODER /
| RESOLVER
| INPUT #1

A 127K

1 SIN INPUT

R 27K

Ris 127K

A6 127K 246

Note: Encoder #2 is identical to Encoder #1. |

Amplifier Output

"DGND"

24 AENALY—PENATL 1|

**NETLIST CHANGE**

MBDALECC

* 4]

Note: Amplifier Output #2 is identical to Amplifier Output #1.

PLANE "AGND" PLANE
AMP-0OUT 1
DACL A+ 1
DACI A- 9
DACI BT 2
DACI B- 0
AE NC T 3
AECOM T i
AENO T 4
AFAULT I+ T
AFAULT T 5
3 3
4o & 6
OTa s ooy 14
. 4
K3 1 4 ALY O—F v 15
+5V 9ot A-12vO 8
3 ——o-L
8 * 4] *k
. T B
o PR AGND
D42 FBR12NDO5S
oMMBD301LTL
U119
NC7SZ00 Yo4
(SOT23:5)
o)
o
GND
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DAC Outputs

" "
AGND" PLANE .
|.c288 sAv12v
RPGSA RP67A
110 1500 10 2
—w veL [He 2.2KSIP8I 1% L D )
I
2 e PWM B T1 DAC_STB1 2| s |5 11.00K 1% R
PWM A B1 DACA DAT1 3 14 LF347M 1 2 -
2 PwMAEBL oL voL ‘ - AL 5 06 2088
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APPENDIX C: SINUSOIDAL INTERPOLATION
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The sine and cosine signals from the encoder are processed in two ways in this product (see above
diagram). First, they are sent through comparators that square up the signals into digital quadrature and
are then sent into the quadrature decoding and counting circuit of the Servo IC on the ACC-24M2A. The
units of the hardware counter, which are called hardware counts, are thus ¥ of a line. For most users, this
fact is an intermediate value, an internal detail that does not concern them. However, this is important in
two cases. First, if the sinusoidal encoder is used for PMAC-based brushless-motor commutation, the
hardware counter (not the fully interpolated position value) will be used for the commutation position
feedback. Therefore, the units of Ixx71 will be hardware counts. Second, if the hardware position-
compare circuits in the Servo IC are used, the units of the compare register are hardware counts. The
same is true of the hardware position-capture circuits, but often these scaling issues are handled
automatically through the move-until-trigger constructs.

The second, parallel processing of the sine and cosine signals is through analog-to-digital converters,
which produce numbers proportional to the input voltages. These numbers are used to calculate
mathematically an arctangent value that represents the location within a single line. This is calculated to
1/4096" of a line, so there are 4096 unique states per line, or 1024 states per hardware count.

For historical reasons, PMAC expects the position it reads for its servo feedback software to have units of
1/32" of a count. That is, PMAC considers the least significant bit (LSB) of whatever it reads for position
feedback to have a magnitude of 1/32™ of a count for the purposes of its software scaling calculations.
We call the resulting software units software counts and any software parameter that uses counts from the
servo feedback (e.g. jog speed in counts/msec, axis scale factor in counts/engineering-unit) is using these
software counts. In most cases, such as digital quadrature feedback, these software counts are equivalent
to hardware counts.

However, with the added resolution produced by the ACC-24M2A interpolator option, software counts
and hardware counts are no longer the same. The LSB produced by the interpolator (through the encoder
conversion table processing) is 1/1024™ of a hardware count, but PMAC software considers it 1/32" of a
software count. Therefore, with the ACC-24M2A, a software count is 1/32" the size of a hardware count.
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The following equations express the relationships between the different units:

1 line = 4 hardware counts = 128 software counts = 4096 states (LSBs)

Ya-line = 1 hardware count = 32 software counts = 1024 states (LSBs)

1/128-line = 1/32-hardware count = 1 software count = 32 states (LSBS)

1/4096-line = 1/1024-hardware count = 1/32-software count = 1 state (LSB)

Note that these are all just naming conventions. Even the position data that is fractional in terms of
software counts is real. The servo loop can see it and react to it, and the trajectory generator can
command to it.
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The Interpolator can accept a voltage-source (1 V) signal from the encoder. The maximum sine-cycle
frequency input is approximately 8 MHz (1,400,000 SIN cycles/sec), which gives a maximum speed of
about 5.734 billion steps per second.

When used with a 1000 line sinusoidal rotary encoder, there will be 4,096,000 discrete states per
revolution (128,000 software counts). The maximum calculated electrical speed of this encoder would be
1,400 RPS or 84,000 RPM, which exceeds the maximum physical speed of most encoders.

Example 1:

A 4-pole rotary brushless motor has a sinusoidal encoder with 2000 lines. It directly drives a screw with a
5-mm pitch.

For servo control, the interpolated results of the conversion table are used. There are 128 software counts
per line, or 256,000 software counts per revolution. With each revolution corresponding to 5 mm on the
screw, there are 51,200 software counts per millimeter. The measurement resolution, at 4096 states per
line, is 1/8,192,000 of a revolution, or 1/1,638,400 of a millimeter (~0.6 nanometers/state).

Example 2:
A linear brushless motor has a commutation cycle of 60.96 mm (2.4 inches). It has a linear scale with a
20-micron line pitch.

The servo uses the interpolated results of the conversion table. With 128 software counts per line, and 50
lines per millimeter, there are 6400 software counts per millimeter (or 162,560 software counts per inch).
The measurement resolution, at 4096 states per line, is 204,800 states per mm (~5 nanometers/state).
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